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Surya Dharma 

Muhammad Gifariyono 
 

 
RINGKASAN 

 
Balai Rawa, Pusat Penelitian dan Pengembangan Sumber Daya Air 
mengembangkan suatu penelitian yang bertujuan mengembangkan teknologi sistem 
tata air yang mampu menekan emisi karbon yang dihasilkan oleh daerah rawa dalam 
mengurangi emisi gas rumah kaca yang mengakibatkan terjadinya perubahan iklim 
global. 

Terkait dengan hal tersebut, dibuat suatu program kerja sama 4 (empat) institusi, 
yaitu: KNMI, BMKG, Puslitbang SDA dan Deltares yang bernama Joint Cooperation 
Programme (JCP) yang bertujuan untuk saling berbagi pengetahuan dan 
meningkatkan kapasitas SDM. Dan dalam kaitannya dengan pengelolaan rawa yang 
berkelanjutan, program ini berada di bawah komponen C3, yaitu Assessing 
Lowland/Peatland Subsidence and Future Drainability. 

Dalam rangka peningkatan pengetahuan di bidang emisi karbon pada lahan gambut 
maka pada tanggal 9–13 Juli 2012 telah diselenggarakan Kegiatan Workshop 
Peatland Carbon Emission and Subsidence Modelling di Direktorat Bina Pengelolaan 
Sumber Daya Air Kementerian Pekerjaan Umum. Workshop ini dihadiri oleh 
perwakilan dari Direktorat Bina Pengelolaan Sumber Daya Air, Direktorat Bina OP, 
Universitas Gajah Mada dan Balai Rawa Puslitbang Sumber Daya Air. Workshop 
berikutnya dengan tujuan lebih memperdalam materi diselenggarakan pada tanggal 
8–11 Oktober 2012 di Balai Rawa, Banjarmasin yang dihadiri oleh peneliti dan staf 
Balai Rawa puslitbang Sumber Daya Air. 

Workshop ini menggunakan data dari Sei Ahas yang terletak di Blok A, lahan gambut 
ex PLG di desa Sei Ahas, Kalimantan Tengah dengan luas ± 50 hektar. 

Dari workshop ini dapat ditarik beberapa kesimpulan, antara lain faktor ketinggian 
muka air tanah sangat penting baik dalam rangka mencegah penurunan muka lahan 
gambut maupun mengurangi besaran emisi karbon pada lahan gambut. Semakin 
dalam penurunan muka air tanah maka semakin lama pula waktu penurunan tanah 
gambut dan semakin tinggi pula besaran emisi karbon. Angka berikut di bawah ini 
memberikan penjelasan lebih lanjut dari uraian di atas. 

URAIAN 
KETEBALAN GAMBUT 

RERATA 
(cm) 

WAKTU PENURUNAN 
GAMBUT 
(tahun) 

Muka Air Musim Kemarau 166.8 67 

Muka Air Banjir 144.7 58 
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Sementara itu dapat dilihat pula bahwa emisi karbon yang terjadi akan semakin 
besar dengan semakin rendahnya muka air tanah. 

URAIAN 

MATERIAL 
GAMBUT 
KERING 
(Mton) 

Volume Karbon Gambut 
(Mton) 

EMISI KARBON 
(Mton) 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT 
(50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT 
(55%) 

Muka Air Sungai 
Musim Kemarau 

2.481 1.240 1,365 4.548 5,003 
 

Muka Air Banjir 
Sungai 

2.157 1.079 1,186 
 

3.955 4,350 
 

 
Selanjutnya dapat dibuktikan bahwa besaran subsidence rate (perkebunan Akasia) 
dengan membangun bendung dan penghutanan kembali, jauh lebih kecil dari pada 
tanpa perlakuan apapun.  Demikian pula yang terjadi dengan besarnya laju emisi 
karbon, antara laju emisi karbon dan laju subsidensi mempunyai perilaku yang sama 
seperti yang telah dijelaskan di atas. Mengingat bahwa sampai saat ini rekaman nilai 
subsidence di lapangan masih sangat pendek, maka pengaruh subsidence terhadap 
emisi karbon dilakukan dengan menggunakan hubungan antara muka air dan 
subsidence dari publikasi (Hooijer et al., 2012a). Kenaikan muka air akibat 
dibangunnya bendung masih merupakan nilai asumsi. 

Sebagai ilustrasi dapat diuraikan sebagai berikut: dengan asumsi, muka air tanah 
rata-rata 0,4 m (kondisi eksisting) dibawah permukaan untuk perkebunan Akasia, 
diperoleh besaran emisi karbon tahunan sebesar 0.095 Mton/tahun. Selanjutnya bila 
dibangun bendung tanpa penghutanan kembali dan dianggap muka air tanah naik 
50% (0,2 m dibawah permukaan, untuk perkebunan Akasia, diperoleh besaran emisi 
karbon tahunan sebesar 0.068 Mton/tahun).  
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1 PENDAHULUAN 
1.1 Umum 

Lahan gambut memiliki potensi yang sangat besar dalam peningkatan emisi 
karbon atau yang disebut juga emisi gas rumah kaca yang saat ini menjadi isu 
utama dalam kaitannya dengan isu pemanasan global dan perubahan iklim. 
Lebih dari setengah dari kandungan gambut tropis dunia terdapat di Asia 
Tenggara khsususnya di Indonesia dan Malaysia (Page et al., 2011). 
Sementara untuk wilayah Indonesia pada tahun 2010 Kementerian Lingkungan 
Hidup bekerja sama dengan IPB telah menyusun Peta Sebaran Kesatuan 
Hidrologis Gambut berdasarkan informasi yang diperolweh dari berbagai 
instansi  dan interpretasi citra satelit (2007)  dimana total sebaran kesatuan 
hidrologis gambut di Indonesia adalah seluas 32.6 Mha yang tersebar di 
Sumatera, Kalimantan, Sulawesi, Papua dan Jawa (Kementerian Lingkungan 
Hidup, 2010). 

Pencanangan target penurunan emisi sebesar 26 persen (41 persen dengan 
dukungan internasional) pada tahun 2020 sebagaimana hasil Conference of the 
Parties (COP 15) di Kopenhagen bulan Desember 2009 lalu merupakan target 
kebijakan nasional. Di sinilah peran lahan rawa pasang surut yang mencakup 
lebih dari 80 persen kawasan gambut di Indonesia menjadi suatu hal yang 
penting. 

Gambut yang menjadi idola, karena fungsinya sebagai penyelamat karena 
mengikat karbon sekaligus sumber CO2 (gas rumah kaca), ternyata berada di 
wilayah lahan rawa pasang surut. Keistimewaan lahan rawa pasang surut juga 
tampak pada kompleksitas masalahnya yang lebih rumit daripada lahan rawa 
lain. Di satu sisi, proses pembangunan nasional mendorong permintaan 
konversi lahan pasang surut; pada sisi lain, dunia internasional pun menuntut 
Indonesia untuk mempertahankan ekosistem lahan rawa pasang surutnya. 

Pelajaran berharga dari pengalaman-pengalaman pengelolaan lahan rawa dan 
gambut sebelumnya, menunjukkan bahwa kita menghadapi kekurang-selarasan 
kebijakan-kebijakan antar sektor dan antar daerah dalam pengelolaan rawa. 
Oleh karena itu maka pemahaman akan pentingnya pendekatan yang 
terintegrasi, menyeluruh, dan multisektor dalam perencanaan nasional tentang 
tata kelola lahan rawa pasang surut berkelanjutan dirasakan sudah semakin 
mendesak. 

1.2 WACLIMAD PROJECT 
Dalam kerangka perencanaan nasional, perhatian dan kesungguhan 
pemerintah dalam pengelolaan lahan rawa yang berkelanjutan, telah 
diwujudkan dengan pembentukan Tim Kordinasi yang dibentuk melalui 
Keputusan Menteri Perencanaan Pembangunan Nasional/Kepala Bappenas 
No.Kep.40/M.PPN/HK/07/2009 yang beranggotakan pejabat Eselon-1 
Kementerian dan Lembaga Pemerintah yang terkait dengan pengelolaan lahan 
rawa pasang surut, yang meliputi Kementerian-kementerian Pekerjaan Umum, 
Lingkungan Hidup, Kehutanan, Pertanian, Kelautan dan Perikanan, Dalam 
Negeri, Tenagakerja dan Transmigrasi, dan Bappenas serta LIPI, BMKG, 
LAPAN, dan Bakosurtanal. Tim Koordinasi ini juga telah dilengkapi dengan 
Sekretariat yang beranggotakan para Eselon-2 dan Kelompok Kerja (Pokja) 
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beranggotakan para Eselon 3 Kementerian/Lembaga terkait. Tim koordinasi ini 
bertugas mengembangkan dialog kebijakan multi- sektor, baik di pusat maupun 
daerah untuk membangun kesepahaman dan kesepakatan yang nantinya 
diharapkan menjadi dasar bagi penyusunan perencanaan nasional pengelolaan 
lahan rawa berkelanjutan. 

Penyusunan Perencanaan Nasional Pengelolaan Lahan Rawa Berkelanjutan”, 
yang diselenggarakan atas kerjasama Pemerintah Indonesia dengan 
pemerintah Kerajaan Belanda dan World Bank melalui kegiatan Water 
Management for Climate Change Mitigation and Adaptive Development 
(WACLIMAD) in Lowlands. 

Serangkaian dialog kebijakan antar sektor telah menghasilkan berbagai 
kesepahaman dan kesepakatan, terutama digunakannya konsep kesatuan 
hidrologis dalam delineasi dataran rendah. Selain telah mengembangkan 
alur pikir zonasi makro dan mezo yang digunakan dalam delineasi, juga telah 
dikembangkan alternatif arah kebijakan pengelolaan kawasan pengelolaan 
adaptif. Hasil yang diperoleh ini dapat dijadikan acuan dalam menyusun 
kebijakan implementasi di masing-masing sektor baik di pusat maupun di 
daerah termasuk sebagai masukan untuk penyusunan/revisi RTRW dan bagi 
peraturan perundangan yang sedang disiapkan. 

1.3 QANS PROJECT 
Selanjutnya bertolak dari rencana perluasan geografis dari WACLIMAD yang 
kemudian berfokus pada dialog regional, baru-baru ini lebih dipusatkan kembali 
berdasar atas diskusi antara PfW, Kedutaan Belanda, dan Pemerintah 
Indonesia (Kementerian Pekerjaan Umum dan BAPPENAS) dalam bentuk 
Quick Assessment and Nationwide Screening of Peat and Lowland Resources 
and Action Planning for the Implementation of a National Lowland Strategy 
(QANS). QANS adalah kegiatan yang didanai oleh The Netherlands Partners 
for Water (PfW) Programme dari 1 March 2012 until 28 February 2013 dan 
dilaksanakan oleh konsorsium yang dipimpin oleh Euroconsult Mott MacDonald, 
bersama dengan Deltares, DHV, WUR and PT. INDEC. 

QANS akan berfokus pada beberapa kegiatan terutama di propinsi Riau, 
Sumatra dan Kalimantan Barat bersama dengan berbagai kegiatan generik 
yang bertujuan untuk mendukung pengembangan lahan rawa Indonesia yang 
berkelanjutan, dan melanjutkan dukungan pada dialog nasional dan regional. 
Secara khusus, di samping berfokus pada pendekatan pengembangan yang 
berkelanjutan, kegiatan ini juga berfokus pada lahan gambut, dimana isu ini 
penting untuk jangka pendek dan menengah. Bila WACLIMAD berpusat pada 
zonasi makro, maka QANS akan lebih rinci pada zonasi yang lebih kecil (zonasi 
mezo), mengidentifikasi areal yang paling sesuai untuk pengembangan, 
rehabilitasi, dan konservasi, atau kombinasinya. 
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1.4 Penelitian Balai Rawa Puslitbang SDA 
Balai Rawa sebagai bagian dari Pusat Penelitian dan Pengembangan Sumber 
Daya Air memiliki suatu kegiatan penelitian yang bertujuan untuk 
mengembangkan suatu teknologi sistem tata air yang mampu menekan emisi 
karbon yang dihasilkan oleh daerah rawa dalam mengurangi emisi gas rumah 
kaca yang mengakibatkan terjadinya perubahan iklim global. Kegiatan 
penelitian ini berlokasi di Blok A, lahan gambut ex PLG di Desa Sei Ahas, 
Kalimantan Tengah seluas ± 50 hektar dan telah dimulai pada tahun 2011 dan 
akan berakhir di tahun 2014, untuk memperoleh gambaran yang lebih jelas, 
lihat Gambar 1. Teknologi sistem tata air yang dikembangkan akan 
menggunakan intervensi hidrologi dalam bentuk bendung yang dikombinasikan 
dengan jalur perahu untuk memberikan fasilitas jalur navigasi. 

 

Gambar 1 Lokasi studi Sei Ahas (Sumber: KFCP, 2009) 

Pengelolaan air Sei Ahas dimaksudkan untuk: 
• Memulihkan lahan gambut yang terdegradasi supaya perlahan-lahan 

kembali menjadi hutan alami/lahan pertanian; 
• Menyediakan air untuk masyarakat; 
• Mengurangi kebakaran; 
• Mencegah subsidensi lahan; 
• Mengurang banjir di musim hujan. 

Pengelolaan air ini dilakukan dengan membuat bendung tetap untuk 
mempertahankan air tidak keluar dari lahan gambut dan sekaligus meninggikan 
muka air di saluran dan lahan.  

Lokasi Studi 

Sei Ahas 
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1.5 Cooperation Programme and Workshops 
Terkait dengan penelitian-penelitian yang dilakukan oleh Balai Rawa tersebut, 
Balai Rawa sangat membutuhkan tenaga-tenaga peneliti yang berpengalaman 
dan handal, maka sangat dibutuhkan transfer ilmu dan kebutuhan akan 
pengetahuan yang up to date serta jitu untuk mengatasi masalah-masalah di 
atas. Sehubungan dengan itu maka dibuat suatu program kerja sama yang 
bernama Joint Cooperation Programme (JCP) yang bertujuan untuk saling 
berbagi pengetahuan dan pembangunan kapasitas jangka panjang antara 4 
(empat) institusi, yaitu: KNMI, BMKG, Puslitbang SDA dan Deltares. Sasaran 
utama dari program ini adalah meningkatkan pengetahuan dari semua institusi 
yang terlibat termasuk Balai Rawa dan untuk meningkatkan kapasitas institusi 
dalam perencanaan, pengembangan dan pengelolaan sistem sumber daya air. 
Dalam kaitannya dengan pengelolaan rawa yang berkelanjutan, program ini 
berada di bawah komponen C3, yaitu assessing lowland/peatland subsidence 
and future drainability. 

Dan dalam rangka peningkatan pengetahuan di bidang emisi karbon pada 
lahan gambut maka pada tanggal 9–13 Juli 2012 telah diselenggarakan 
Kegiatan Workshop Peatland Carbon Emission and Subsidence Modelling di 
Direktorat Bina Pengelolaan Sumber Daya Air Kementerian Pekerjaan Umum. 
Workshop ini dihadiri oleh perwakilan dari Direktorat Bina Pengelolaan Sumber 
Daya Air, Direktorat Bina OP, Universitas Gajah Mada dan Balai Rawa 
Puslitbang Sumber Daya Air. Bertindak sebagai instruktur dalam kegiatan ini 
adalah Dr. Aljosja Hooijer dan Ronald Vernimmen, yang keduanya berasal dari 
Deltares. 

Selanjutnya untuk memperdalam materi dari workshop I diselenggarakan 
workshop II pada tanggal 8–11 Oktober 2012 di Balai Rawa Banjarmasin. 
workshop II ini dihadiri oleh peneliti dan staf Balai Rawa dengan pengajar 
adalah Marnix Van der Vat dari Deltares, dimana hasil dari kedua workshop 
tersebut di atas dilaporkan pada laporan ini.  

Lokasi bendung disajikan pada Gambar 2. 
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Gambar 2 Lokasi bendung 

Untuk tidak mengganggu manfaat saluran sebagai alur navigasi yang 
dibutuhkan olen masyarakat setempat, maka diperlukan bangunan alur perahu 
(shiplocks) yang dibangun menyatu dengan bendung tersebut. Adapun cara 
kerja bangunan alur perahu tersebut dapat di lihat pada Gambar 3. 

 

Gambar 3 Cara kerja bangunan alur perahu 
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2 KONSEP UTAMA 
2.1 Gambut dan Subsidence 

Lahan gambut sejatinya adalah penyimpan cadangan karbon dan karbon tidak 
akan hilang pada kondisi alaminya. Ketika lahan gambut didrainase untuk 
berbagai kepentingan, seperti pembukaan lahan untuk pertanian dan 
perkebunan atau untuk diambil kayunya, maka lahan gambut akan mengalami 
penurunan (subsidence). 

Lebih dari setengah (24,8 juta ha) dari luas global lahan gambut tropis berada 
di Asia Tenggara (56%), sebagian besar berada di Indonesia dan Malaysia. 
Dengan asumsi ketebalan gambut (rata-rata > 5 m ) pada di kedua negara ini, 
maka keduanya memiliki 77% dari seluruh simpanan karbon gambut (Page et 
al., 2011). 

Simpanan karbon pada lahan gambut akan stabil bila lahan gambut tidak 
dikeringkan melalui proses drainase, dalam hal ini pengendalian muka air tanah 
gambut adalah kunci utama agar karbon tidak terlepas ke udara melalui proses 
oksidasi. Menurut penelitian Hooijer et al. (2012), pada kedalaman muka air 0,7 
m, "perkebunan Akasia" dan "hutan alami" mempunyai tingkat subsidensi yang 
sama (Gambar 4) dan garis linier "perkebunan Akasia" dapat digunakan untuk 
hutan gambut alami yang dikeringkan ketika kedalaman muka air rata-rata di 
bawah 0,7 m (Hooijer et al., 2012). 

 

Gambar 4  Hubungan 
antara tinggi muka air tanah dengan 
penurunan permukaan gambut 
(Hooijer et al., 2012a) 

Terdapat tiga faktor utama yang 
dinilai sebagai kontribusi utama 
penyebab penurunan muka tanah 
pada lahan gambut (et al., 2012a), 
yaitu: oksidasi karbon, pemadatan 
dan penyusutan, serta konsolidasi. 

Drainase berlebih pada lahan gambut 
dapat menyebabkan penurunan 

 
Gambar 5  Proses Penurunan Gambut 
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permukaan lahan (subsidence) yang signifikan sebagai akibat dari penyusutan 
gambut dan oksidasi karbon yang dampak akhirnya adalah pengurangan 
kandungan karbon pada lahan gambut. Tingkat oksidasi karbon pada lahan 
gambut yang telah dibuka dinilai sebagai sebab utama dari peningkatan emisi 
gas rumah kaca dunia. Diperkirakan kehilangan karbon hasil dari emisi carbon 
dioksidasi dari lahan gambut bervariasi mulai dari 40 hingga 60 t CO2-
eq/ha/tahun dengan asumsi kedalaman muka air tanah sekitar 0,7 m (Hooijer et 
al., 2006), belum termasuk kehilangan karbon akibat dari kebakaran lahan. 

Gambar 5, menunjukkan bahwa dalam kondisi alami dimana tidak terjadi 
drainase berlebih, gambut dapat dikonservasi sehingga tidak terjadi emisi 
sebagai dampak dari pengeringan lahan. Proses emisi karbon pada lahan mulai 
terjadi setelah dilakukan pengeringan lahan melalui proses drainase, yang 
berdampak pada penurunan muka lahan gambut hingga kemudian berakhir 
pada saat elevasi gambut sama dengan elevasi muka air saluran. 

Untuk mengetahui berapa sebenarnya tingkat emisi karbon yang ada pada 
lahan gambut di Indonesia, diperlukan suatu metode pendekatan yang simpel 
namun akurat sehingga dapat digunakan sebagai dasar dalam proses 
perencanaan dan penentuan kebijakan pengelolaan selanjutnya. Untuk itu 
diperlukan adanya pengukuran terhadap tingkat penurunan muka tanah yang 
dikombinasi dengan data karakteristik gambut, salah satu diantaranya data 
ketebalan gambut, sebagai data pokok dalam analisa perhitungan emisi karbon 
pada lahan gambut. 

Bila lahan gambut terus mengalami penurunan dan akhirnya mencapai elevasi 
muka air sungai musim kemarau akibat dari subsidensi di atas, maka 
masalahpun berakhir, yaitu lahan gambut tidak mungkin akan turun lebih 
rendah lagi.  

Subsidensi selain diakibatkan oleh oksidasi (emisi karbon), juga disebabkan 
oleh komponen lain, yaitu kompaksi, penyusutan (shrinkage) dan konsolidasi.  

Oksidasi karbon merupakan proses dekomposisi karbon pada lahan gambut 
yang telah di keringkan sehingga menyebabkan penurunan kadar organik pada 
gambut akibat dari oksidasi gas CO2. 

Kompaksi terjadi akibat dari tekanan pada permukaan gambut yang disebabkan 
oleh peralatan berat, sedangkan penyusutan terjadi melalui kontraksi serat 
organik yang mengering. Pada prakteknya, kedua proses ini sering tak dapat 
dibedakan, dan keduanya dianggap sebagai kompaksi.  

Konsolidasi dibedakan atas Konsolidasi Primer dan Sekunder, Konsolidasi 
Primer disebabkan oleh kehilangan air pori pada gambut, proses ini 
berlangsung cepat bila air tanah berpindah secara cepat, terutama pada sistem 
drainase yang rapat pada gambut dengan permeabilitas yang tinggi.. 
Sementara itu Konsolidasi Sekunder adalah fungsi dari tahanan material 
gambut padat terhadap kompresi, proses konsolidasi ini berlangsung lambat 
dan hanya merupakan bagian kecil dari konsolidasi total (Hooijer et al., 2012a). 
Konsolidasi umumnya terjadi di tahun-tahun pertama setelah terjadi drainase, 
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kemudian prosentasi oksidasi akan konstan dan dapat dihitung dengan 
persamaan. 

Selanjutnya volume gambut yang hilang akibat dari oksidasi dan kompaksi 
serta prosentasi subsidensi akibat oksidasi dapat dihitung dengan persamaan 
(Driessen and Soepraptohardjo,1974): 

Vox = ((V1 * BD1) − (Vrest * BD2))/BD1 

dan: 

Vcomp = Vrest * (BD2 − BD1)/BD1 

dan 

Pox = Vox * BD1/(Vox * BD1) + (Vcomp * BD1)  

dimana: 
- Vox = Volume gambut yang hilang akibat oksidasi (cm3); 
- Vcomp = Volume gambut yang hilang akibat kompaksi (cm3); 
- Vrest = Volume gambut sesudah subsidensi, di atas muka air anah 

terdalam (cm3); 
- V1 = Volume gambut sebelum subsidensi, di atas muka air tanah 

terdalam (cm3); 
- BD1 = Bulk density asli di atas muka air tanah terdalam (g cm-3); 
- BD2 = Bulk density baru di atas muka air tanah terdalam, sesudah 

subsidensi (g cm-3); 
- Pox = Prosentasi subsidensi akibat oksidasi (%). 

Upaya konservasi untuk mencegah penurunan muka tanah pada lahan gambut 
sangat penting dilakukan karena jika penurunan permukaan ini berlangsung 
terus menerus, pada tahap tertentu akan berdampak pada tingkat drainabilitas 
lahan dimana lahan akan terus tergenangi karena tinggi permukaan lahan yang 
sangat rendah sehingga air tidak dapat terdrainase ke sungai. Upaya 
konservasi pada lahan gambut dapat dilakukan dengan mempertahankan tinggi 
muka air tanah setinggi mungkin yaitu dengan cara memasang pintu-pintu air 
pada saluran. Namun bila kondisi memungkinkan, lebih baik bila saluran ditutup 
total dengan tanggul gambut yang dipadatkan. 
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2.2 Gambut dan Karbon 
2.2.1 Volume gambut 

Volume gambut total adalah volume dari suatu area gambut yang terpilih yang 
dihitung dari perkalian antara kedalaman gambut (tinggi dari permukaan lahan 
gambut sampai dengan dasar gambut) dengan luasan area terpilih tersebut. 
Perlu diketahui bahwa tidak semua volume gambut total akan teroksidasi, 
sebagian dari volume tersebut masih akan tersimpan sebagai karbon sampai 
gambut tersebut berada di bawah muka air (Drainage Limit, DL). 

Pada umumnya volume gambut yang digunakan adalah volume gambut di atas 
DL, yaitu volume gambut yang terletak antara permukaan lahan gambut sampai 
dengan garis asumsi batas drainase, dimana dalam hal ini diasumsikan garis 
tersebut mempunyai kemiringan 20 cm/km dari muka air banjir di sungai 
(Hooijer et al. 2012b). 

2.2.2 Bulk density 
Bulk density (BD) adalah berat total massa kering dari bubuk, butiran-butiran 
tanah, atau pecahan benda padat dibagi dengan total volume (g cm-3). Proses 
oksidasi murni pada lahan gambut tidak meningkatkan nilai BD dan pada 
kenyataannya bahkan dapat mengurangi. Sebaliknya pada proses kompaksi 
dan konsolidasi, keduanya akan meningkatkan nilai BD (Hooijer et al., 2012a). 

Nilai BD bervariasi terhadap kedalaman gambut (lihat Annex 1), semakin dalam 
gambut, maka akan semakin kecil nilai BD-nya. Berikut adalah gambaran dari 
besaran nilai BD. 

 

Gambar 6  Sebaran bulk density pada lahan gambut berdasarkan kedalamannya 
(Hooijer et al., 2012a) 

2.2.3 Kandungan karbon 
Kandungan karbon pada umumnya diambil sekitar 50% - 55%, nilai ini bila 
dikalikan dengan berat kering material akan menjadi jumlah karbon yang hilang. 
Dimana berat kering material adalah volume gambut yang teroksidasi dikalikan 
dengan nilai Bulk Density (BD). Selanjutnya besaran emisi karbon ekivalen 
diperoleh dengan mengalikan berat kering karbon dengan faktor 3,66. Faktor ini 
berasal dari berat molar CO2/berat molar karbon, yaitu: 44.0095/12.0107 = 3,66.  
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Sebagai ilustrasi diberikan contoh dalam angka sebagai berikut: 
Volume gambut  = 0,01 m * 10.000 m2  =  100 m3 
Volume oksidasi  = 80% * 100 m3  =  80 m3 
Dry material  = BD * 80 m3 = 0,1 * 80 m3  =  8 ton DM 
Karbon  = 50% * 8 ton DM  =  4 ton CO 
Emisi karbon  = 4 ton C * 3,66  =  15 ton CO2/ha/cm  

(Lihat Annex 2 untuk penjelasan lebih lanjut). 

Nilai kandungan karbon mempunyai dampak proporsional terhadap perhitungan 
kehilangan karbon akibat subsidensi. Dengan asumsi nilai kandungan karbon 
diambil sebesar 50% - 60% sebagai pengganti dari nilai 55% yang umum 
digunakan (dari literatur) pada kondisi gambut fibrik dan hemik dengan 
kandungan mineral rendah, maka akan mengurangi atau menambah besaran 
kehilangan karbon sebanyak 10% (Hooijer et al., 2012a). 

2.3 Hidrologi dan Pengelolaan Air 
2.3.1 Batas drainase (drainage limit) 

Batas drainase didefinisikan sebagai garis kemiringan yang diasumsikan 
sebagai pembawa dari muka air banjir sungai atau muka air sungai musim 
kemarau bila sungai yang menjadi acuan, dan muka air rata-rata laut (MSL) bila 
laut yang menjadi acuan, menuju ke lahan dengan faktor kemiringan 0,2 m per 
km panjang. Kemiringan pembawa ini menunjukkan kemiringan muka air yang 
harus dipertahankan di saluran agar hujan dapat didrainase dari lahan. Nilai 
kemiringan 0,2 m per km panjang adalah nilai yang umum digunakan atau 
aturan praktis (rule of thumb) pada desain dan perkiraan sistem drainase, 
misalnya DID Sarawak (2001) dan Hooijer et al. (2012b). Batas drainase dapat 
dianggap sebagai garis batas, dimana masalah drainase mulai terjadi. Pada 
saat muka air sungai tinggi, apabila lahan gambut berada di bawah batas 
drainase ini maka dapat dikatakan bahwa drainase tidak dapat dilakukan dan 
akan mengakibatkan banjir. Untuk lebih jelasnya, lihat Gambar 7. 

 

Gambar 7 Garis batas drainase 

Selanjutnya muka air banjir sungai dan muka air sungai musim kemarau 
didefinisikan sebagai berikut: 
Muka air banjir sungai adalah elevasi muka air tertinggi di sungai pada saat 
banjir di musim hujan. Muka air ini bisa lebih tinggi lagi pada sungai yang masih 
dipengaruhi oleh pasang surut air laut, yaitu saat dimana air laut pasang. 
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Muka air sungai musim kemarau adalah elevasi muka air rata-rata di sungai 
pada saat musim kemarau. Muka air ini bisa lebih rendah lagi pada sungai yang 
masih dipengaruhi oleh pasang surut air laut, yaitu saat dimana air laut surut. 

2.4 Penurunan Muka Tanah Lahan Gambut (Subsidence) 
2.4.1 Hubungan antara tinggi muka air rata-rata dengan penurunan permukaan tanah 

Penurunan permukaan tanah pada lahan gambut dapat dikorelasikan 
berbanding lurus dengan kedalaman muka air tanah (Hooijer et al., 2012a). 
Hasil penelitian menunjukkan bahwa semakin dalam muka air tanah akan 
berdampak pada semakin tingginya tingkat penurunan permukaan lahan. 
Gambar 4 di atas menunjukkan bahwa pemanfaatan lahan juga berpengaruh 
terhadap tingkat penurunan permukaan lahan. Tingkat penurunan lahan pada 
area pertanian lebih tinggi dibandingkan dengan hutan alami. Bahkan untuk 
lahan pertanian, penurunan permukaan lahan akan terus terjadi meskipun tinggi 
muka air tanah dipertahankan menyamai tinggi muka tanah. 

Hooijer et al. (2012a) membuat suatu persamaan linear yang menghubungkan 
antara tingkat penurunan permukaan lahan gambut dengan tinggi muka air 
tanah rata-rata baik untuk lahan perkebunan Akasia dan lahan hutan alami . 
Persamaan tersebut dapat dijabarkan sebagai berikut: 

Lahan perkebunan Akasia :  S = 1,5 - 4,98 * WD .............. (Persamaan 1) 

Lahan hutan alami :  S = 0,69 - 5,98 * WD ........... (Persamaan 2) 

Dimana, S adalah tingkat penurunan permukaan tanah gambut rata-rata dalam 
satu tahun (cm/tahun) dan WD adalah rata-rata kedalaman muka air tanah (- m, 
negatif). 

3 METODOLOGI (lihat juga Annex 2) 
3.1 Gambut dan Karbon 
3.1.1 Perhitungan volume gambut 

Data awal yang digunakan adalah peta elevasi (peta yang dihasilkan dari 
LiDAR pengindraan dengan menggunakan teknologi laser) lokasi studi Sei 
Ahas yang sudah dilengkapi dengan layout saluran dengan detail elevasi 
permukaan lahan serta elevasi air pada saluran. Peta elevasi untuk Sei Ahas 
ditampilkan dalam bentuk raster dengan resolusi 100 m (sumber: proyek KFCP, 
processed by Deltares) sebagai layer pertama dalam pemodelan ini. 
Perhitungan dilakukan dengan menggunakan perangkat lunak GIS (QGIS). 

Data kedua yang digunakan adalah data sebaran kedalaman gambut yang 
dimodelkan dalam bentuk shape file (format titik coklat pada gambar 8) pada 
lokasi yang sama. Peta shape file untuk data kedalaman gambut ini kemudian 
dikonversi menjadi peta kontur sebaran ketebalan gambut (data raster). Tahap 
selanjutnya peta elevasi dikombinasikan dengan peta kontur sebaran 
kedalaman gambut dengan cara interpolasi data raster dengan menggunakan 
raster calculation (peta elevasi dikurangi dengan peta sebaran kedalaman data 
gambut) untuk menghasilkan peta elevasi dasar gambut. 

Kedalaman gambut yg digunakan dalam latihan ini berasal dari: CKPP (2005, 

2007); jumlah titik pengukuran sebanyak 65 buah dengan rentang kedalaman 
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0,5 – 10,15 m, KFCP (2011); jumlah titik pengukuran sebanyak 366 buah 

dengan rentang 0 – 9,72 m, Balai Rawa (2011 – 2012); jumlah titik pengukuran 

sebanyak 38 buah dengan rentang kedalaman 0 - >6 m, Puslitanak (1992); 

jumlah titik pengukuran sebanyak 11 buah dengan rentang kedalaman 0 - 6 m, 

untuk lebih jelasnya lihat Annex 1. Pada workshop 8–11 Oktober 2012, data 

CKPP dihilangkan karena nilainya sangat tinggi dibandingkan data dari sumber 

yg lain. 

Peta elevasi kemudian dibandingkan dengan peta elevasi dasar gambut, untuk 
menentukan volume gambut. 

Bila peta elevasi ini kemudian dibandingkan dengan kedalaman permukaan air 
tanah, maka diperoleh volume gambut yang dapat terkosidasi. Dalam hal ini 
gambut yang dapat teroksidasi adalah gambut yang berada di atas permukaan 
air tanah. 

Kondisi permukaan air tanah pada lahan gambut sangat bervariasi. Permukaan 
air tanah pada musim hujan akan lebih tinggi dibanding dengan musim kering. 
Selain itu, kondisi tinggi muka air pada saluran juga akan berpengaruh terhadap 
tinggi muka air tanah. Hooijer et al. (2012a) mempergunakan tinggi muka air 
tanah rata-rata dalam satu tahun untuk menentukan hubungan antara tinggi 
muka air tanah dengan tingkat penurunan permukaan lahan gambut. Lihat 
Gambar 4 di atas. 
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Interpolasi dari Point Shape File menjadi 
Peta Kontur Ketabalan Gambut

Data Point Shape 
File Sebaran 

Ketebalan Gambut

Peta Kontur 
Ketebalan Gambut

 

Peta Elevasi Sei. 
Ahas (PETA LIDAR)

Peta Elevasi Dasar Gambut (Peat 
Bottom Map)

Raster Calculation (Peta LIDAR – Peta 
Kontur Ketebalan Gambut)

 

Gambar 8 Proses analisa untuk memperoleh peta elevasi dasar gambut 

Selanjutnya dibuat kontur sebaran muka 
air dengan asumsi kenaikan muka air 
sebesar 20 cm/km, dan hasil kontur 
tersebut ditambahkan dengan peta 
sebaran air sungai pada musim hujan. 

Proses interpolasi dilakukan dengan cara 
pembuatan satu layer baru (shape file) 
yang menggambarkan sebaran data 
elevasi muka air saluran. Dari data shape 
file distribusi sebaran muka air saluran ini 
kemudian dilakukan proses interpolasi 
untuk memperoleh peta kontur sebaran 
muka air tanah (data raster). 

Tahap selanjutnya adalah menyusun layer 
baru yang digunakan untuk menentukan 
lapisan gambut yang dapat teroksidasi, 

dalam hal ini dinamakan dengan peta batas gambut teroksidasi. Lapisan 

 
 

 
 
 
 

 
 
 
 

 
 
 

Kandungan gambut 

Kedalaman permukaan air tanah 

Volume gambut yang dapat teroksidasi 

Gambar 9 Volume gambut yang 

dapat teroksidasi 



18 
 

gambut yang teroksidasi adalah lapisan gambut yang terletak di atas 
permukaan air tanah. Sementara tidak semua tanah yang ada di permukaan air 
tanah adalah tanah gambut, sebagian berupa tanah mineral yang tidak 
teroksidasi. 

Peta Kontur Sebaran 
Muka Air Tanah

Peta Elevasi Dasar 
Gambut (Peat 
Bottom Map)

Peta Batas Gambut Teroksidasi

Raster Calculation (Nilai Tertinggi antara 
Peta Elevasi Dasar Gambut dengan Peta 

Kontu Sebaran Muka Air Tanah) 

 

Gambar 10  Proses interpolasi untuk menghasilkan peta batas gambut 
teroksidasi 

Peta batas gambut teroksidasi merupakan nilai elevasi tertinggi yang diperoleh 
dari perbandingan antara peta kontur sebaran muka air tanah dengan peta 
elevasi dasar gambut (Gambar 10). Peta batas gambut teroksidasi inilah yang 
dipergunakan sebagai dasar perhitungan volume gambut yang dapat 
teroksidasi. 

3.1.2 Simpanan karbon 
Perhitungan volume gambut yang dapat teroksidasi dilakukan dengan cara 
mengalikan ketebalan gambut di atas muka air tanah dengan nilai persen 
oksidasi, yaitu diambil 80% untuk Sei Ahas (tidak ada referensi, hanya petunjuk 
dari ALJOSJA, Ronald bisa tolong bantu cari referensinya ?), nilai bulk density 
gambut dan luasan lahan.  

Sementara itu volume gambut yang dapat teroksidasi dapat dihitung dengan 
menggunakan metode raster calculation dimana peta elevasi permukaan 
dikurangi dengan peta batas gambut teroksidasi, yaitu bila  muka air tanah 
masih di bawah batas drainase.Hasilnya dalam hal ini dinamakan peta volume 
gambut yang dapat teroksidasi yaitu berupa sebaran kedalaman gambut di atas 
batas drainase. Terdapat beberapa batas drainase yang bisa digunakan, dalam 
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workshop ini digunakan 2 (dua) buah batas drainase, yaitu: batas drainase 
0,2m/km darimuka air sungai saat banjir dan muka air sungai musim kemarau. 

Perhitungan jumlah simpanan karbon yang ada dari total berat kering gambut 
dapat diketahui dengan mengalikan peta volume gambut yang dapat teroksidasi 
dengan faktor 55% kandungan karbon (Hooijer et al. 2012a). 

3.1.3 Emisi karbon 
Emisi karbon tahunan rata-rata dapat dihitung dengan membagi nilai simpanan 
karbon dengan jumlah tahun bila semua gambut habis teroksidasi (yaitu untuk 
gambut di atas batas drainase  muka air banjir di sungai atau di atas muka air 
sungai musim kemarau). 

Sementara itu jumlah tahun gambut habis teroksidasi dapat diperoleh dari 
ketebalan gambut teroksidasi dibagi dengan laju penurunan lahan gambut 
(subsidence rate) dalam cm/tahun. Sedangkan laju penurunan lahan gambut 
diperoleh dari grafik di Gambar 4. Selanjutnya simpanan karbon dapat diubah 
menjadi CO2 ekivalen dengan mengalikan angka simpanan karbon dengan 
faktor 3,66. Dari emisi karbon tahunan rata-rata selanjutnya dapat dihitung 
emisi karbon 25, 50 atau 100 tahun ke depan (bila gambut belum habis). 
Perhitungan dilakukan dengan pertama-tama meninjau terlebih dahulu volume 
gambut yang tersedia. Dalam workshop diasumsikan kedalaman muka air 
tanah tahunan rata-rata, kemudian diperoleh laju subsidensi dan dilanjutkan 
dengan perhitungan berapa lama hal ini berlangsung sebelum batas drainase 
tercapai. Selanjutnya berdasarkan waktu ini dapat diperoleh emisi karbon untuk 
sekian tahun mendatang dan belum tentu mencapai nilai 50 atau 100 tahun ke 
depan. 

 

Gambar 11 Hubungan antara tinggi muka air tanah dengan tingkat emisi karbon 
per tahun (Hooijer et al., 2012a) 

Berdasarkan grafik hubungan antara tinggi muka air tanah dengan tinggi emisi 
karbon per tahun (Hooijer et al., 2012a) seperti pada Gambar 11 di atas, maka 
dapat diperkirakan dengan ketinggian muka air tanah rata-rata berkisar 0,4 m, 
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dapat diperkirakan akan menghasilkan emisi karbon (CO2) tiap tahun sebesar 
kurang lebih 50 ton per hektar. 

 

 

Penurunan gambut dan laju emisi karbon 
Skenario dari perhitungan kecepatan penurunan gambut, waktu penurunan 
gambut dan laju emisi karbon dapat diuraikan sebagai berikut : 
- Kondisi tidak ada bendung dan tanpa penghutanan kembali 
- Kondisi ada 3 bendung dan tanpa penghutanan kembali 
- Kondisi ada 3 bendung dan penghutanan kembali 
- Kondisi tidak ada bendung, tanpa penghutanan kembali dan adanya 

kebakaran 

Selanjutnya metode perhitungan dari hal-hal di atas dapat diuraikan sebagai 
berikut: 
Kecepatan penurunan gambut (subsidence rate) di Sei Ahas, dihitung dengan 
persamaan (1) di atas  

Water depth average (WD) diasumsikan sebesar 0,4 m, maka kecepatan 
penurunan gambutnya di kawasan Sei. Ahas. 

Selanjutnya waktu penurunan gambut yang dibutuhkan diketahui dari ketebalan 
gambut maksimum di atas drainage limit, flood river level, dan dry season river 
level dibagi dengan nilai subsidence rate: 

 …………… (Persamaan 3) 

Laju emisi karbon dapat dihitung dengan cara membagi emisi karbon dengan 
waktu penurunan gambut, sebagai berikut: 

 …………… (Persamaan 4) 

Untuk perhitungan kecepatan penurunan gambut, waktu penurunan karbon dan 
laju emisi karbon di kawasan Sei. Ahas (kondisi ada 3 bendung dan tanpa 
penghutanan kembali), laju penurunan gambut (subsidence rate) dihitung 
dengan nilai WD tereduksi sebesar menjadi 50%, yaitu 0,2 m karena 
dipengaruhi adanya 3 buah bendung. 

Demikian pula untuk perhitungan kecepatan penurunan gambut, waktu 
penurunan karbon dan laju emisi karbon di kawasan Sei. Ahas (kondisi ada 3 
bendung dan penghutanan kembali), laju penurunan gambut (subsidence rate) 
dihitung dengan nilai WD, yaitu 0,2 m dengan persamaan sebagai berikut: 

 ………….. (Persamaan 5) 

Untuk perhitungan kecepatan penurunan gambut, waktu penurunan karbon dan 
laju emisi karbon di kawasan Sei. Ahas (kondisi tidak ada bendung, tanpa 
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penghutanan kembali dan adanya kebakaran) diambil data dan asumsi 
sebagai berikut: 

Berdasarkan peta sebaran kebakaran lahan gambut di Kawasan Sei. Ahas 
tahun 2001-2009, diketahui adanya 54 titik api dari 27  grid cells di kawasan Sei 
Ahas (MODIS fire hotspots cells). Sehingga kalau dirata-ratakan maka 
diperoleh 2,19 titik api per grid cell (2,19 fires/grid cell)  dan untuk selama 9 
tahun diperoleh 0,243 fires/grid cell/year. Diasumsikan dari setiap 1 titik api 
terjadi penurunan lahan gambut sebesar 10 cm/tahun (Page,??). Dengan 
kondisi tidak adanya bendung, tanpa penghutanan kembali dan terjadi 
kebakaran, maka persamaan yang digunakan adalah: 

 … (6) 

3.2 Batas Hidrologi  
Batas drainase (drainage limit) 
Batas drainase dalam perhitungan di sei Ahas ini diambil dari muka air di 
sungai dengan faktor kemiringan 0,2 m per km panjang. Batas drainase  pada 
perhitungan ini dilakukan baik yang terjadi pada musim kemarau maupun pada 
musim banjir sungai. 

Muka air sungai musim kemarau 
Muka air sungai musim kemarau adalah elevasi muka air rata-rata di sungai 
pada saat musim kemarau. Dalam studi ini diasumsikan bahwa muka air saat 
musim kering pada Sungai Kapuas adalah 0.99 m. Hal ini berdasarkan dari 
hasil rerata data pengamatan muka air di muara saluran lokasi studi baik pada 
waktu neap tides (1–2 Oktober 2012) maupun pada spring tides (8–9 Oktober 
2012) yang bertepatan pada musim kering. Pengikatan elevasi muka air 
dilakukan melalui Bench Mark yang dipasang dan Peta LIDAR (KFCP, 2012). 

Muka air banjir sungai 
Muka air banjir sungai adalah elevasi muka air tertinggi di sungai pada saat 
banjir di musim hujan. Tapi dalam studi ini diketahui bahwa pada saat banjir, 
elevasi tinggi muka air sebesar 1.59. Sama akan halnya pada musim kering, 
data ini diperoleh dari data hasil rerata pengamatan muka air lapangan baik 
pada waktu neap tides (31 Mei – 1 Juni 2012) maupun pada spring tides (6–8 
Juni 2012) yang bertepatan pada musim basah. 

Catatan: 
Sei Ahas terletak ± 160 km (mengikuti alur sungai) dari muara Sungai Kapuas, 
oleh karena itu muka air banjir dan muka air musim kemarau di sungai lebih 
tinggi dari MSL. 

3.3 Intervensi Hidrologi  
Dalam workshop ini dilakukan 4 (empat) skenario tindakan/perlakuan hidrologi 
sebagai berikut: 
- Kondisi tanpa bendung dan tanpa penghutanan kembali,  
- Kondisi dengan 3 bendung tanpa penghutanan kembali,  
- Kondisi dengan 3 bendung dan penghutanan kembali, serta  
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- Kondisi tanpa bendung dan tanpa penguhutanan kembali dengan adanya 
kebakaran. 

 
Pembangunan bendung akan menaikkan muka air di saluran. Dengan kenaikan 
muka air ini maka laju penurunan lahan gambut juga akan berbeda, demikian 
pula dengan besarnya nilai emisi karbon. 
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4 HASIL STUDI 
Dari hasil komputasi diperoleh hasil sebagai berikut: 
1. Besaran volume gambut, volume karbon dan emisi karbon di Kawasan Sei. 

Ahas untuk berbagai kedalaman air tanah dapat dilihat pada Tabel 1 di 
bawah 

Tabel 1 Volume Gambut di Kawasan Sei Ahas 

URAIAN 
VOLUME 
GAMBUT 

(Mm
3
) 

VOLUME 
GAMBUT 

TEROKSIDASI 
(Mm

3
) 

MATERIAL 
GAMBUT 
KERING 
(Mton) 

VOLUME KARBON 
GAMBUT 

(Mton) 

EMISI KARBON 
(Mton) 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

Gambut 
keseluruha
n 

36.070 28.856 2.775 1.387 1.526 5.087 5.596 

Gambut di 
atas muka 
air sungai 
musim 
kemarau 

32.065 25.652 2.481 1.240 1.365 4.548 5.003 

Gambut di 
atas 
drainage 
limit 
(musim 
kemarau) 

27.078 21.662 2.113 1.057 1.162 3.874 4.262 

Gambut di 
atas muka 
air banjir 
sungai  

27.876 22.301 2.157 1.079 1.186 3.955 4.350 

Gambut di 
atas 
drainage 
limit (banjir 
sungai) 

21.629 17.303 1.677 0.839 0.923 3.075 
 

3.383 

Volume gambut teroksidasi diperoleh dengan mengalikan volume gambut 
dengan nilai oksidasi sebesar 80%, sedang volume gambut kering adalah 
hasil perkalian volume gambut teroksidasi dengan nilai bulk density. 
Selanjutnya volume karbon gambut adalah volume gambut kering dikali 
dengan nilai kandungan karbon untuk gambut dangkal sebesar 50% dan 
55% (nilai rata-rata), selanjutnya besaran emisi karbon diperoleh dari 
volume karbon dikalikan dengan faktor 3,66. 

Material gambut kering di Tabel 1 diatas telah diverifikasi secara manual 
dengan Ms. Excel dan keduanya memberikan hasil yang sama. 

Perhitungan di atas dilakukan pada kawasan Sei Ahas dengan luasan area 
kurang lebih 19057973.6 m2 (1905.8 ha), kedalaman gambut bervariasi 
antara 0 m s/d 6 m dengan rata-rata kedalaman gambut 1.8755 m 

2. Laju subsidensi, besaran kecepatan penurunan gambut dan waktu 
penurunan di kawasan Sei. Ahas dengan kondisi tanpa bendung dan tanpa 
penghutanan kembali, kondisi dengan 3 bendung tanpa penghutanan 
kembali, kondisi dengan 3 bendung dan penghutanan kembali, serta kondisi 
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tanpa bendung dan tanpa penguhutanan kembali dengan adanya kebakaran 
pada berbagai kedalaman air tanah dapat dilihat pada Tabel 2 di bawah. 

Tabel 2 Laju subsidensi (Persamaan 1), kecepatan dan waktu penurunan gambut 
(Persamaan 3) di kawasan Sei Ahas 

URAIAN 

ACTUAL 
CONDITION; 

SUBSIDENCE 
RATE 3,5 
CM/YEAR 

3 DAM; NO 
REFORESTATION; 

SUBSIDENCE RATE 
2,5 CM/YEAR 

3 DAM; 
REFORESTATION; 

SUBSIDENCE RATE 
1,6 CM/YEAR 

NO DAM; NO 
REFORESTATION; 

FIRES; 
SUBSIDENCE RATE 

5,9 CM/YEAR 

KECE
PATA

N 
PENU
RUNA

N 
GAMB

UT 
(Cm/T
ahun) 

WAKT
U 

PENU
RUNA

N 
GAMB

UT 
(Tahun

) 

KECEPA
TAN 

PENURU
NAN 

GAMBU
T 

(Cm/Tah
un) 

WAKTU 
PENUR
UNAN 

GAMBU
T 

(Tahun) 

KECEPAT
AN 

PENURU
NAN 

GAMBUT 
(Cm/Tahu

n) 

WAKTU 
PENUR
UNAN 

GAMBU
T 

(Tahun) 

KECEPAT
AN 

PENURU
NAN 

GAMBUT 
(Cm/Tahu

n) 

WAKTU 
PENUR
UNAN 

GAMBU
T 

(Tahun) 

Gambut 
Keseluruhan 

3.492 54 2.496 75 1.618 116 5.920 32 

GAMBUT di atas 
Muka Air Musim 
Kemarau 

3.492 48 2.496 67 1.618 103 5.920 28 

Gambut di atas 
Batas Muka Air 
Tanah (Musim 
Kemarau) 

3.492 40 2.496 56 1.618 87 5.920 24 

Gambut di atas 
Muka Air Banjir 

3.492 41 2.496 58 1.618 89 5.920 24 

Gambut di atas 
Batas Muka Air 
Tanah (Musim 
Banjir) 

3.492 32 2.496 45 1.618 69 5.920 19 

 
Ketebalan gambut maksimum di kawasan Sei Ahas adalah 6 m. 

3. Besaran laju emisi dan emisi karbon 25 tahun, 50 tahun dan 100 tahun 
dengan kondisi tanpa bendung dan tanpa penghutanan kembali, kondisi 
dengan 3 bendung tanpa penghutanan kembali, kondisi dengan 3 bendung 
dan penghutanan kembali, serta kondisi tanpa bendung dan tanpa 
penguhutanan kembali dengan adanya kebakaran pada berbagai 
kedalaman muka air tanah disajikan pada Tabel 3 di bawah ini. 
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Tabel 3  Laju emisi karbon dan emisi karbon 25 tahun, 50 tahun, dan 100 tahun di kawasan Sei Ahas (Carbon Content Shallow Peat 
50%) 

URAIAN 

ACTUAL CONDITION 3 DAM; NO REFORESTATION 3 DAM; REFORESTATION NO DAM; NO REFORESTATION; FIRES 

LAJU 
EMISI 

KARBON 
(Mton/Thn) 

EMISI KARBON (Mton) 
LAJU EMISI 

KARBON 
(Mton/Thn) 

EMISI KARBON (Mton) 
LAJU EMISI 

KARBON 
(Mton/Thn) 

EMISI KARBON (Mton) 
LAJU EMISI 

KARBON 
(Mton/Thn) 

EMISI KARBON (Mton) 

25 
Thn 

25 - 50 
Thn 

50 -100 
Thn 

25 
Thn 

25 - 50 
Thn 

50 - 
100 
Thn 

25 
Thn 

50 
Thn 

50 -100 
Thn 

0 - 25 
Thn 

25 - 50 
Thn 

100 
Thn 

Gambut 
Keseluruh
an 

0.095 2.37
5 

4.736 
(50 thn) 

5,087 
(54 thn) 

0.068 1.69
3 

3.385 
(50 thn) 

6.771 
(75 
thn) 

0.044 1.09
7 

2.19
4 

4.389 
(100 
thn) 

0.161 4.015 
(25 thn) 

5.087 
(32 thn) 

- 

Gambut di 
atas Muka 
Air Musim 
Kemarau 

0.095 2.38
0 

4.548 
(48 thn) 

- 0.068 1.70
1 

3.403 
(50 thn) 

6.805 
(67 
thn) 

0.044 1.10
3 

2.20
6 

4.411 
(100 
thn) 

0.161 4.035 
(25 thn) 

4.548 
(28 thn) 

- 

Gambut di 
atas Batas 
Muka Air 
Tanah 
(Musim 
Kemarau) 

0.096 2.40
1 

3.874 
(40 thn) 

- 0.069 1.71
6 

3.432 
(50 thn) 

6.864 
(56 
thn) 

0.044 1.11
2 

2.22
5 

3.874 
(87 thn) 

0.163 3.874 
(24 thn) 

- - 

Gambut di 
atas Muka 
Air Banjir 

0.095 2.38
6 

3.955 
(41 thn) 

- 0.068 1.70
5 

3.410 
(50 thn) 

6.821 
(58 
thn) 

0.044 1.10
5 

2.21
1 

3.955 
(89 thn) 

0.162 3.955 
(24 thn) 

- - 

Gambut di 
atas Batas 
Muka Air 
Tanah 
(Musim 
Banjir) 

0.096 2.39
0 

3.075 
(32 thn) 

- 0.068 1.70
8 

3.075 
(45 thn) 

- 0.044 1.10
7 

2.21
5 

3.075 
(69 thn) 

0.162 3.075 
(19 thn) 

- - 
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Tabel 4  Laju emisi karbon dan emisi karbon 25 tahun, 50 tahun, dan 100 tahun di kawasan Sei Ahas (Carbon Content Shallow Peat 
55%) 

URAIAN ACTUAL CONDITION 3 DAM; NO REFORESTATION 3 DAM; REFORESTATION NO DAM; NO REFORESTATION; FIRES 

LAJU 
EMISI 

KARBON 
(Mton/Thn) 

EMISI KARBON (Mton) LAJU EMISI 
KARBON 

(Mton/Thn) 

EMISI KARBON (Mton) LAJU EMISI 
KARBON 

(Mton/Thn) 

EMISI KARBON (Mton) LAJU EMISI 
KARBON 

(Mton/Thn) 

EMISI KARBON (Mton) 

25 
Thn 

25 - 50 
Thn 

50 -100 
Thn 

25 
Thn 

25 - 50 
Thn 

50 - 
100 
Thn 

25 
Thn 

50 
Thn 

50 -100 
Thn 

0 - 25 
Thn 

25 - 50 
Thn 

100 
Thn 

Gambut 
Keseluruh

an 

0.104 2.60
5 

5.210 
(50 thn) 

5.596 
(54 thn) 

0,074 1.86
2 

3.724 
(50 thn) 

5.596 
(75 
thn) 

0.048 1.20
7 

2.41
4 

4.828 
(100 
thn) 

0.177 4.416 
(25 thn) 

8.832 
(32 thn) 

- 

Gambut di 
atas Muka 
Air Musim 
Kemarau 

0.105 2.61
8 

5.003 
(48 thn) 

- 0,075 1.87
1 

3.743 
(50 thn) 

5.003 
(67 
thn) 

0.049 1.31
3 

2.42
6 

4.852 
(100 
thn) 

0.178 4.439 
(25 thn) 

8.877 
(28 thn) 

- 

Gambut di 
atas Batas 
Muka Air 
Tanah 
(Musim 

Kemarau) 

0.106 2.64
1 

4.262 
(40 thn) 

- 0,076 1.88
8 

3.775 
(50 thn) 

4.262 
(56 
thn) 

0.049 1.22
4 

2.44
7 

4.262 
(87 thn) 

0.179 4.262 
(24 thn) 

- - 

Gambut di 
atas Muka 
Air Banjir 

0.105 2,62
4 

4.350 
(41 thn) 

- 0,075 1.87
6 

3.751 
(50 thn) 

4.350 
(58 
thn) 

0.049 1.21
6 

2.43
2 

4.350 
(89 thn) 

0.178 4.350 
(24 thn) 

- - 

Gambut di 
atas Batas 
Muka Air 
Tanah 
(Musim 
Banjir) 

0.105 2.62
9 

3.383  
(32 thn) 

- 0,075 1.87
9 

3.383 
(45 thn) 

- 0.049 1.21
8 

2.43
6 

3.383 
(69 thn) 

0.178 3.383 
(19 thn) 

- - 
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4. Besaran subsidensi dan  emisi karbon yang dihasilkan pada tahun pertama 
sampai pada tahun ke-50 di kawasan Sei. Ahas pada kondisi alamiah tanpa 
rehabilitasi, kondisi pengembangan lahan perkebunan, kondisi adanya 
bendung, kondisi adanya bendung dan penghutanan kembali disajikan pada 
Tabel 4 di bawah. 

Besaran subsidensi diperoleh dengan cara perhitungan menggunakan 
software Ms. Excel. Dalam perhitungan ini adapun data-data yang mesti 
disiapkan yaitu: 
a. Cadangan karbon awal (initial carbon stock), untuk mendapatkannya 

dengan menggunakan rumus dibawah ini; 
Initial Carbon Stock (MTon CO2) = Peat Volume * Carbon Content* BD 

* Carbon Ratio 

b. Parameter lainnya yang diperlukan, yaitu: 
- Luas wilayah (area – Mm2); 
- Elevasi lahan gambut awal rerata (initial average peat surface level – 

m); 
- Kedalaman saluran awal rerata (initial canal bottom depth – m); 
- Elevasi muka air musim kering (dry season river level – m); 
- Kandungan karbon gambut dangkal (carbon content shallow peat – 

50%); 
- Kandungan oksidasi karbon gambut (carbon content oxidation – 

80%); 
- Bulk density karbon kering (dry bulk density – g/cm3); 

Nilai data ini ditentukan dari nilai ketebalan gambut rata-rata pada 
kawasan suatu kawansan studi. 

- Rasio karbon (carbon ratio – 3.67); 
- Kedalaman air tanah awal (ground water depth start – m) 

Untuk data ini dari hasil asumsi, berikut data asumsi berdasarkan 
berbagai kondisi yang dapat digunakan: 
1) Kondisi alamiah tanpa rehabilitasi: 0.4 m; 
2) Kondisi pengembangan lahan perkebunan: 0.8 m; 
3) Kondisi adanya bendung: 0.3 m; 
4) Kondisi adanya bendung dan penghutanan kembali: 0.3 m. 

c. Elevasi air tanah minimum (ground water level minimum - m); 
GWL minimum (m) = initial average peat surface level – initial canal 

bottom depth 

d. Kedalaman air tanah akhir (ground water depth end – diasumsikan tidak 
ada air tanah sehingga dianggap 0,0 m); 

e. Laju penurunan gambut awal (subsidence start – m/y); 
Data ini berguna untuk mengetahui besaran penurunan gambut awal, 
berikut untuk mendapatkan nilai besaran penurunannya berdasarkan 
dari berbagai kondisi: 
1) Kondisi alamiah tanpa rehabilitasi; 

Subsidence start (m/y)  = 0.015+0.0498*GWD start 
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2) Kondisi pengembangan lahan perkebunan; 
Subsidence start (m/y)  = 0.015+0.0498*GWD start 

3) Kondisi adanya bendung; 
Subsidence start (m/y)  = 0.015+0.0498*GWD start 

4) Kondisi adanya bending dan penghutanan kembali; 
Subsidence start (m/y)  = 0.0706*GWD start 

f. Laju penurunan gambut awal (subsidence end – m/y); 
Data ini berguna untuk mengetahui besaran penurunan gambut akhir 
sehingga dapat diketahui tahun keberapa ketersedian gambut yang 
tersisa, berikut untuk mendapatkan nilai besaran penurunannya 
berdasarkan dari berbagai kondisi: 
1) Kondisi alamiah tanpa rehabilitasi; 

Subsidence end (m/y)  = 0.015+0.0498*GWD endt 

2) Kondisi pengembangan lahan perkebunan; 
Subsidence end (m/y)  = 0.015+0.0498*GWD end 

3) Kondisi adanya bendung; 
Subsidence end (m/y)  = 0.015+0.0498*GWD end 

4) Kondisi adanya bending dan penghutanan kembali; 
Subsidence end (m/y)  = 0.0706*GWD end 
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Tabel 5 Emisi Karbon di Kawasan Sei Ahas Selama 50 Tahun (Canal Blocking and Reforestation) 

Subsidence Emission Subsidence Emission Subsidence Emission Subsidence Emission

(m) (MtonCO2/y) (m) (MtonCO2/y) (m) (MtonCO2/y) (m) (MtonCO2/y)

0 0.035 0.147 0.055 0.230 0.030 0.126 0.0212 0.0889

1 0.035 0.147 0.055 0.230 0.028 0.119 0.0197 0.0826

2 0.035 0.147 0.055 0.230 0.027 0.113 0.0183 0.0768

3 0.035 0.147 0.055 0.230 0.026 0.108 0.0170 0.0714

4 0.035 0.147 0.055 0.230 0.024 0.102 0.0158 0.0663

5 0.035 0.147 0.055 0.230 0.023 0.097 0.0147 0.0616

6 0.035 0.147 0.055 0.230 0.022 0.092 0.0137 0.0573

7 0.035 0.147 0.055 0.230 0.021 0.088 0.0127 0.0532

8 0.035 0.147 0.055 0.230 0.020 0.084 0.0118 0.0495

9 0.035 0.147 0.055 0.230 0.019 0.079 0.0110 0.0460

10 0.035 0.147 0.055 0.230 0.018 0.075 0.0102 0.0427

11 0.035 0.147 0.055 0.230 0.017 0.072 0.0095 0.0397

12 0.035 0.147 0.055 0.230 0.016 0.068 0.0088 0.0369

13 0.035 0.147 0.055 0.230 0.015 0.065 0.0082 0.0343

14 0.035 0.147 0.055 0.230 0.015 0.063 0.0076 0.0319

15 0.035 0.147 0.055 0.230 0.015 0.063 0.0071 0.0296

16 0.035 0.147 0.055 0.230 0.015 0.063 0.0066 0.0275

17 0.035 0.147 0.055 0.230 0.015 0.063 0.0061 0.0256

18 0.033 0.141 0.055 0.230 0.015 0.063 0.0057 0.0238

19 0.032 0.134 0.055 0.230 0.015 0.063 0.0053 0.0221

20 0.030 0.127 0.055 0.230 0.015 0.063 0.0049 0.0206

21 0.029 0.121 0.055 0.230 0.015 0.063 0.0046 0.0191

22 0.027 0.115 0.055 0.230 0.015 0.063 0.0042 0.0178

23 0.026 0.109 0.052 0.219 0.015 0.063 0.0039 0.0165

24 0.025 0.103 0.050 0.209 0.015 0.063 0.0037 0.0153

25 0.023 0.098 0.047 0.198 0.015 0.063 0.0034 0.0143

26 0.022 0.093 0.045 0.188 0.015 0.063 0.0032 0.0132

27 0.021 0.089 0.043 0.179 0.015 0.063 0.0029 0.0123

28 0.020 0.084 0.040 0.170 0.015 0.063 0.0027 0.0114

29 0.019 0.080 0.038 0.143 0.015 0.063 0.0025 0.0106

30 0.018 0.076 0.037 0.000 0.015 0.063 0.0024 0.0099

31 0.017 0.072 0.035 0.000 0.015 0.063 0.0022 0.0092

32 0.016 0.069 0.033 0.000 0.015 0.063 0.0020 0.0085

33 0.016 0.065 0.031 0.000 0.015 0.063 0.0019 0.0079

34 0.015 0.063 0.030 0.000 0.015 0.063 0.0018 0.0074

35 0.015 0.063 0.028 0.000 0.015 0.063 0.0016 0.0069

36 0.015 0.063 0.027 0.000 0.015 0.063 0.0015 0.0064

37 0.015 0.063 0.026 0.000 0.015 0.063 0.0014 0.0059

38 0.015 0.063 0.024 0.000 0.015 0.063 0.0013 0.0055

39 0.015 0.063 0.023 0.000 0.015 0.063 0.0012 0.0051

40 0.015 0.063 0.022 0.000 0.015 0.063 0.0011 0.0048

41 0.015 0.063 0.021 0.000 0.015 0.063 0.0011 0.0044

42 0.015 0.063 0.020 0.000 0.015 0.063 0.0010 0.0041

43 0.015 0.063 0.019 0.000 0.015 0.063 0.0009 0.0038

44 0.015 0.063 0.018 0.000 0.015 0.063 0.0008 0.0035

45 0.015 0.063 0.017 0.000 0.015 0.063 0.0008 0.0033

46 0.015 0.063 0.016 0.000 0.015 0.063 0.0007 0.0031

47 0.015 0.063 0.015 0.000 0.015 0.063 0.0007 0.0028

48 0.015 0.063 0.015 0.000 0.015 0.063 0.0006 0.0026

49 0.015 0.063 0.015 0.000 0.015 0.063 0.0006 0.0025

50 0.015 0.063 0.015 0.000 0.015 0.063 0.0005 0.0023

Canal Blocking, Resforestation

Year

Actual Situation
Autonomous Development - 

Plantation
Canal Blocking
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5 KESIMPULAN 
Faktor ketinggian muka air tanah sangat penting baik dalam rangka mencegah 
penurunan muka lahan gambut maupun mengurangi besaran emisi karbon 
pada lahan gambut. Semakin dalam penurunan muka air tanah maka semakin 
lama pula waktu penurunan tanah gambut dan semakin tinggi pula besaran 
emisi karbon. 

Pada Tabel 5 terlihat bahwa pada muka air tanah yang semakin rendah, 
ketebalan gambut yang akan hilang semakin besar dan waktu penurunan 
gambut semakin lama. 

Tabel 6  Korelasi ketinggian muka air tanah dan waktu penurunan gambut (3 dams, No 
resforeststation) 

URAIAN 
Ketebalan Gambut 

Kering Rerata 
(cm) 

Waktu Penurunan 
Gambut 
(tahun) 

Gambut Keseluruhan 187.6 75 

Gambut di atas Muka Air Musim 
Kemarau 

166.8 67 

Gambut di atas Batas Drainase Muka 
Air Tanah (Musim Kemarau) 

140.9 56 

Gambut di atas Muka Air Banjir 144.7 58 

Gambut di atas Batas Drainase Muka 
Air Tanah (Musim Banjir) 

112.3 45 

Sementara itu dapat dilihat pula dari Tabel 6 bahwa emisi karbon yang terjadi 
akan semakin besar dengan semakin rendahnya muka air tanah. 

Tabel 7  Korelasi ketinggian muka air tanah dengan besaran emisi karbon (Carbon 
Content Shallow Peat 50%) 

URAIAN 
Material Gambut 

Kering 
(Mton) 

Volume Karbon 
Gambut 
(Mton) 

Emisi Karbon 
(Mton) 

Gambut Keseluruhan 2.775 1.387 5.087 

Gambut di atas Muka Air 
Sungai Musim Kemarau 

2.481 1.240 4.548 

Gambut di atas Drainage 
limit (Musim Kemarau) 

2.113 1.057 3.874 

Gambut di atas Muka Air 
Banjir Sungai 

2.157 1.079 3.955 

Gambut di atas Drainage 
Limit (Banjir Sungai) 

1.677 0.839 3.075 

Selanjutnya dari hasil perhitungan dapat disimpulkan bahwa subsidence rate 
tanpa perlakuan apapun besarnya = 3,492 cm/tahun dan dengan kondisi ada 3 
bendung serta tanpa penghutanan kembali, besarnya = 2,496 cm/tahun (hasil 
ini diperoleh dengan menggunakan persamaan 1 dari Hooijer et al. 2012, untuk 
perkebunan Akasia dengan nilai WD tereduksi diasumsikan menjadi 50%, yaitu 
0,2 m karena dipengaruhi adanya 3 buah bendung sehingga subsidence rate 
turun sekitar 1 m/tahun)Dan dengan kondisi adanya 3 bendung serta 
penghutanan kembali, besarnya = 1.618 cm/tahun. Namun dengan kondisi 
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tidak ada bendung, tanpa penghutanan kembali dan adanya kebakaran, maka 
besarnya = 5,920 cm/tahun. 

Kecepatan penurunan gambut (subsidence rate) tersebut, dihitung dengan 
persamaan sebagai berikut (Hooijer et al., 2012) pada kondisi untuk 
perkebunan Akasia (lihat persamaan 1):  

 

Nilai WD dengan adanya 3 bendung direduksi sebesar menjadi 50% dari 
kondisi tanpa perlakuan apapun (0,4 m), menjadi 0,2 m. Dengan kata lain, 
dengan adanya 3 bendung bila muka air diasumsikan naik 0,2 m maka 
subsidence rate turun sebesar: (1 – (2,496/3,492)) * 100% = 28,5% 

Demikian pula yang terjadi dengan besarnya laju emisi karbon, antara laju emisi 
karbon dan laju subsidensi mempunyai perilaku yang sama seperti telah 
diuraikan di atas. 

Pada kondisi di atas drainage limit baik pada musim kemarau dan musim banjir, 
laju emisi karbon tanpa perlakuan apapun = 0,096 Mton/tahun dan 0,096 
Mton/tahun dengan kondisi ada 3 bendung serta tanpa penghutanan kembali, 
besarnya = 0,069 ton/tahun dan 0,068 Mton/tahun (hasil ini diperoleh dengan 
menggunakan persamaan 1 dari Hooijer et al. 2012, untuk perkebunan Akasia 
dengan nilai WD tereduksi diasumsikan menjadi 50%, yaitu 0,2 m karena 
dipengaruhi adanya 3 buah bendung sehingga subsidence rate turun sekitar 1 
m/tahun). Dan dengan kondisi adanya 3 bendung serta penghutanan kembali, 
besarnya = 0,044 Mton/tahun dan 0,044 Mton/tahun. Namun dengan kondisi 
tidak ada bendung, tanpa penghutanan kembali dan adanya kebakaran, maka 
besarnya = 0,163 Mton/tahun dan 0,162 Mton/tahun. 

Untuk perhitungan dengan metode yang lain besaran emisi karbon yang 
dihasilkan selama 50 tahun pada kondisi tanpa perlakuan = 5,28 Mton/tahun 
dan pada kondisi pengembangan lahan untuk perkebunan besarnya 6,60 
Mton/tahun. Sedangkan pada kondisi ada 3 bendung, besarnya 3,62 
Mton/tahun dan pada kondisi ada bendung serta penghutanan kembali, 
besarnya 1,23 Mton/tahun. 
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7 ANNEX 
7.1 Annex 1 

Data LiDAR diperoleh dari Deltares/KFCP berdasarkan pengukuran yang 
dilakukan pada bulan Agustus sampai dengan bulan Oktober 2011 saat musim 
kemarau. 

Data kedalaman gambut diperoleh dari beberapa sumber sebagai berikut: 
- CKPP (2005, 2007),  
- KFCP (2011),  
- Balai Rawa (2011–2012),  
- Puslitanak (1992). 

Nilai Bulk Density bervariasi terhadap kedalaman gambut, dalam workshop ini 
diambil nilai sebagai berikut: 
- Gambut kedalaman 0 – 2 m, nilai BD = 0.15 gr/cm3 
- Gambut kedalaman 2 – 4 m, nilai BD = 0,10 gr/cm3 
- Gambut kedalaman >4 m , nilai BD = 0,07 gr/cm3 
Nilai ini diperoleh dari Hooijer et al., 2012a. 

Sementara itu, nilai kandungan karbon pada umumnya diambil sebesar 50% -  
60% atau rata-rata sebesar 55%. Nilai ini umum digunakan (dari literatur) pada 
kondisi gambut fibrik dan hemik dengan kandungan mineral rendah (Hooijer et 
al., 2012a). 

7.2 Annex 2 (Lihat File Annex 2) 
 

http://onlinelibrary.wiley.com/doi/10.1002/jgrd.v113.D23/issuetoc
http://onlinelibrary.wiley.com/doi/10.1002/jgrd.v113.D23/issuetoc


1. METODOLOGI  

Proses pemodelan untuk perhitungan kandungan gambut, tingkat penurunan 

lahan serta emisi karbon dilakukan dengan menggunakan aplikasi sistem 

informasi geografis dalam hal ini software yang digunakan adalah Quantum GIS 

Desktop karena bersifat open source.  

Berikut ini merupakan tahapan kegiatan pemodelan gambut dengan 

menggunakan Quantum GIS 1.8 (http://www.qgis.org/) 

1. Untuk langkah pertama yang harus dipersiapkan adalah peta elevasi lokasi 

studi di Sei. Ahas yang sudah dilengkapi dengan layout saluran dengan detail 

elevasi permukaan lahan serta elevasi air pada saluran. Peta elevasi untuk 

Sei. Ahas ditampilkan dalam bentuk raster dengan resolusi spatial 100 m 

(format file .tif) sebagai layer pertama dalam pemodelan ini; 

 

Gambar 1.1 Contoh file peta elevasi Sei. Ahas 

Untuk file layout Sungai Kapuas dan saluran-saluran Sei. Ahas dengan 

menggunakan nama file “polygon-river-KalTeng-utm50S” dengan format file 

.shp; .shx; .sbx; .sbn; .prj; dan .dbf. 

2. Data kedua yang harus disiapkan juga adalah data sebaran kedalaman 

gambut 

Untuk data sebaran kedalaman gambut sendiri berupa data yang berisi 

berupa data koordinat (x – easting, y – northing) dan data kedalaman gambut. 

Koordinat data ini harus sama kedalam zona dengan koordinat peta elevasi 

yang dimiliki. Dalam studi ini data ada pengurangan data, yaitu data CKPP 



dihilangkan karena data CKPP memiliki kecenderungan ketebalan gambutnya 

lebih besar dibandingkan data dari KFCP, PUSAIR dan PUSLITANAK. 

 

Gambar 1.2 Data Sebaran Gambut di Sei. Ahas dalam fotmat file .csv 

Data sebaran gambut yang dimodelkan harus dalam format shape file dengan 

titik referensi koordinat yang sama dengan layout sungai dan saluran. Untuk 

contoh diatas data sebaran gambut harus dikonversikan ke dalam format 

shape file dengan menggunakan perangkat lunak CSV2SHP software 

(http://www.mapwindow.org/downloads/index.php?show_details=30). Untuk 

jelasnya, lihat gambar di bawah. 

 

Gambar 1.3 Konversi file .csv ke dalam format shape file dengan CSV2SHP 
Software 

http://www.mapwindow.org/downloads/index.php?show_details=30


3. Setting Project, Sistem Koordinat Referensi (Coordinate Reference System) 

Aplikasi sistem informasi geografis dalam hal ini software yang digunakan 

adalah Quantum GIS Desktop versi 1.8. Untuk pemodelan ini digunakan 

coordinate reference system yaitu WGS 84 / UTM, dan untuk lokasi studi Sei. 

Ahas berada didalam zona 50S. 

Langkah awal buka menu “Settings” > Klik “Project properties” > Klik 

“Coordinate Reference System (CSR)”, Ikuti Gambar: 

 

Gambar 1.4 “Project properties” pada Quantum GIS Desktop versi 1.8 

Klik Enable ‘On The Fly’ CRS Transformation > sesuaikan zona pada 

Coordinate Reference System > pilih  “WGS 84 / UTM 50S” > setelah itu klik 

OK. Maka pada layar QGIS 1.4 sudah masuk di zona WGS 84 / UTM 50S. 

4. Proses klasifikasi data sebaran ketebalan gambut 

Langkah pertama adalah buka data yang telah disiapkan baik melalui “Add 

vector layer” maupun melalui “Add Raster Layer” pada QGIS 1.8. Lihat 

gambar di bawah adalah peta elevasi, layout sungai dan saluran serta data 

sebaran kedalaman gambut di Sei. Ahas yang telah ditampilkan pada QGIS 

1.8. 



 

Gambar 1.5 Contoh data yang ditampilkan pada QGIS 1.8 

Setelah semua data kedalaman gambut ditampilkan pada QGIS 1.8, anda 

dapat membuat klasifikasi berdasarkan kelas ketebalan gambut. Caranya 

adalah klik kanan layers data kedalaman gambut > Properties > Style > ganti 

“Single Symbol” dengan “Categorized” > pada “Column” cari kategori yang 

disesuaikan (kategori kelas ketebalan gambut/peat class) > lalu klik “Classify”. 

Lihat gambar dibawah ini. 

 

Gambar 1.6 “Layer properties” dalam pembuatan klasifikasi ketebalan gambut 



 

Gambar 1.7 Contoh data ketebalan gambut telah diklasifikasikan 

5. Membatasi peta elevasi berdasarkan wilayah lokasi studi 

Dalam proses ini digunakan “Raster Clipper” dalam membatasi wilayah pada 

peta elevasi. Lihat gambar di bawah ini. 

 

Gambar 1.8 Proses dalam penggunaan “raster clipper” 

Klik menu “Raster” > Extraction > Clipper > klik “Select” pada “Output Files” 

yang berfungsi untuk menentukan tempat penyimpan file peta elevasi yang 

akan dibatasi > klik tombol  untuk menentukan wilayah yang akan 

dibatasi > OK > Close. 



 

Gambar 1.9 Contoh peta elevasi yang telah dibatasi 

Spesifikasi peta elevasi yang telah dibuat tadi dapat diketahui dengan cara 

berikut ini: 

              

Gambar 1.10 Cara mengetahui spesifikasi peta elevasi 

Berdasarkan cara di atas diketahui bahwa: 

- Cell size: 100 m 

- X min: 209500 

- Y min: 9739500 

- X max: 217700 

- Y max: 974200 

6. Proses interpolasi peta ketebalan gambut keseluruhan/Peat Total Map 



Buatlah kontur ketebalan gambut berdasarkan dengan klasifikasi kedalaman 

gambut yang telah dibuat secara manual berupa line. Layer > New > New 

Shapefile Layer… > setelah itu akan muncul “New Vector Layer”, perhatikan 

gambar dan setting di bawah ini. 

 

Gambar 1.11 Setting layer kontur gambut 0 m 

Lalu klik “Toggle Editing” > Add Feature, buatlah kontur yang diinginkan > Save 

> klik kembali “Toggle Editing”. Lihat gambar di bawah kontur yang telah selesai 

dibuat. 



 

   Gambar 1.12 Kontur klasifikasi ketebalan gambut 

Langkah berikutnya menginterpolasi antara kontur ketebalan gambut yang 

diklasifikasikan dengan Peta LIDAR untuk membentuk Peta Ketebalan Gambut 

sesuai dengan klasifikasi yang telah dibuat sebelumnya.  

Klik menu “Raster” > Interpolation > Interpolation > pilih data yang akan 

diinterpolasi, lalu perhatikan kotak berwarna merah pada gambar di bawah - data 

isian harus sesuai dengan spesifikasi dengan peta elevasi (lihat kembali langkah 

5) > OK > Klik kanan layer hasil interpolasi pilih “Properties” > setting sesuaikan 

dengan gambar di bawah, lalu klik “Load” > klik “Color Map” pilih “Pseudocolor” > 

OK. Untuk lebih jelas perhatikan gambar dibawah ini.  



 

Gambar 1.13 Langkah-langkah interpolasi pembuatan peta ketebalan gambut 
keseluruhan/peat extent map 

7. Proses pembuatan peta elevasi dasar gambut/Peat Bottom Map 

Sekarang sudah dipunyai data, yaitu: 

a. Peta elevasi permukaan gambut di Desa Sei. Ahas (peta elevasi), 

b. Peta ketebalan gambut hasil interpolasi (peta ketebalan gambut). 

Pada prinsipnya elevasi dasar gambut diperoleh dari hasil pengurangan antara 

data elevasi atas permukaan gambut (peta elevasi) dengan data ketebalan 



gambut (peta ketebalan gambut). Pada QGIS 1.8 dapat dilakukan perhitungan 

tersebut dengan menggunakan peta elevasi dan peta ketebalan gambut yang di 

olah di atas, yaitu: 

Klik menu “Raster” > Raster Calculator > lalu lihat pada “Raster Bands”, pilih 

raster peta elevasi untuk dikurangi dengan raster Peta ketebalan Gambut > OK.  

 

Gambar 1.14 Setting “Raster Calculator” 

 

Gambar 1.15 Peat bottom map 

Sampai pada tahapan ini sudah dipunyai data sebagai berikut: 

a. Peta Elevasi Permukaan Gambut (peat surface elevation map); 

b. Peta Ketebalan Gambut (peat thickness map) 

c. Peta Elevasi Dasar Gambut (peat bottom map). 



Perbandingan antara ketiga data tersebut dapat dilihat pada plugins “Value 

Tool”. 

 

Gambar 1.16 Data yg ditampilkan pada plugins “Value Tool” 

Apabila pada plugins QGIS anda tidak ada menampilkan “Value Tool”, maka 

anda dapat mengkaktifkannya, yaitu: Plugins > Manage Plugin > cari dan klik 

“Value Tool” > OK. Untuk QGIS yang tidak punya plugins ini bisa di download di 

http://plugins.qgis.org/plugins/plugins.xml melalui “Plugins” > Fetch Python 

Plugins 

 

Gambar 1.17 “Manage Plugin” untuk mengaktifkan “Value Tool” 

http://plugins.qgis.org/plugins/plugins.xml


8. Proses pembuatan Peta Ketebalan Gambut Di Atas Muka Air Sungai Musim 

Kering/Peat Thickness Map above Dry Season River Level 

Dalam studi ini diketahui bahwa elevasi muka air saat musim kering pada Sungai 

Kapuas adalah 0.99 m. Hal ini berdasarkan dari hasil rerata data pengamatan 

muka air di muara saluran lokasi studi baik pada waktu neap tides (1-2 Oktober 

2012) maupun pada spring tides (8-9 Oktober 2012) yang bertepatan pada 

musim kering. Berikut langkah-langkah pembuatan petanya: 

- Klik menu “Raster” > Raster Calculator  

- Perhatikan contoh setting perhitungannya di bawah ini > OK 

 

Gambar 1.18 Contoh setting “Raster Calculator” untuk mendapatkan Dry Season 
River Elevation Map 

 

Gambar 1.19 Dry season elevation map 



- Peta dry season river elevation sendiri harus dikombinasikan dengan peat 

bottom map untuk mendapatkan dry season river elevation correction map. 

Hal ini dimaksudkan untuk mendapatkan ketinggian peat bottom yang 

mungkin akan teroksidasi. Apabila peat bottom dibawah dry season river 

elevation maka   bagian yang dibawah dry season river elevation tidak akan 

teroksidasi. Namun untuk gambut di atas dry season river elevation akan 

teroksidasi. Untuk mendapatkannya dilakukan dua kali perhitungan dengan 

menggunakan raster calculator. Berikut contoh perhitungannya: 

1. Elevasi peat bottom berada di bawah elevasi dry season river elevation 

Klik menu “Raster” > Raster Calculator… > lalu ketik “(peat bottom map < 

dry season elevation map) * dry season river elevation map” > OK. Lihat 

contohnya di bawah ini: 

  

Gambar 1.20 Contoh penggunaan “Raster Calculator” 

2. Elevasi peat bottom berada di atas elevasi dry season river elevation 

Klik menu “Raster” > Raster Calculator… > lalu ketik “(peat bottom map > 

dry season elevation map) * peat bottom map” > OK. Lihat contohnya di 

bawah ini: 



  

Gambar 1.21 Contoh penggunaan “Raster Calculator” 

Dari hasil perhitungan tersebut akan menghasilkan dua buah peta, maka 

semua peta tersebut harus digabungkan dalam satu peta dengan cara 

menambahkan kedua peta tersebut dengan menggunakan “raster calculator”. 

Di bawah ini merupakan dry season river elevation correction map dari hasil 

pengabungan dua buah peta dari hasil perhitungan. 

  

Gambar 1.22 Dry season river elevation correction map 

- Buatlah peta ketebalan gambut di atas batas muka air musim kemarau/peat 

thickness above dry season river level map dengan cara pengurangan antara 

peta elevasi dan dry season river elevation correction map dengan 



menggunakan raster calculator (lihat kembali tahapan pengerjaannya pada 

langkah 7). 

  

Gambar 1.23 Peat thickness above dry season river level map 

9. Proses pembuatan Peta Ketebalan Gambut Di Atas Muka Air Banjir Sungai/Peat 

Thickness Map above Flood River Level 

Dalam studi ini diketahui bahwa pada saat banjir, elevasi tinggi muka air sebesar 

1.59. Sama akan halnya pada musim kering, data ini diperoleh dari data hasil 

rerata pengamatan muka air lapangan baik pada waktu neap tides (31 Mei-1 Juni 

2012) maupun pada spring tides (6-8 Juni 2012) yang bertepatan pada musim 

basah. Untuk langkah pembuatan peta elevasi pada saat banjir sama dengan 

langkah-langkah pengerjaan pembuatan peta pada musim kering (lihat kembali 

langkah 8). Berikut ini merupakan peta elevasi pada saat banjir:  

  



Gambar 1.24 Flood river elevation map 

- Flood river elevation map sendiri harus dikombinasikan dengan peat bottom 

map untuk mendapatkan flood river elevation correction map (lihat kembali 

tahapan pengerjaannya pada langkah 8). 

  

Gambar 1.25 Flood river elevation correction map 

- Buatlah peta ketebalan gambut baik di atas batas muka air musim banjir/peat 

thickness above flood river level map (lihat kembali tahapan pengerjaannya 

pada langkah 7). 

  

Gambar 1.26 Peat thickness above flood river level map 



10. Proses Pembuatan Peta Ketebalan Gambut Di Atas Batas Drainase Muka Air 

Tanah Musim Kering/Peat Thicknes Map Above Drainage Limit Dry Season 

- Dalam studi ini diasumsikan bahwa muka air mengalami kenaikan dari muara 

saluran menuju hulu saluran sebesar 20 cm/km; 

- Buatlah kontur sebaran muka air dengan asumsi kenaikan muka air sebesar 

20 cm/km (langkah pengerjaan lihat kembali langkah 6); 

- Setelah itu interpolasi kontur sebaran muka air tersebut agar didapatkan peta  

sebaran batas muka air tanah/drainage limit map (langkah pengerjaan lihat 

kembali langkah 7); 

  

Gambar 1.27 Drainage limit map 

- Untuk mendapatkan peta elevasi sebaran muka air tanah batas drainase 

musim kering/ dry season river drainage limit elevation map didapatkan dari 

hasil penambahan dari dry season river elevation map dengan peta sebaran 

muka air tanah batas drainase musim kering (langkah pengerjaan lihat 

kembali langkah 7); 



   

Gambar 1.28  Drainage limit elevation (dry season river) map 

- Selanjutnya mengkombinasikan antara peat bottom map dengan Peta elevasi 

sebaran muka air tanah batas drainase musim kering (lihat kembali langkah 

8). 

   

Gambar 1.29 Drainage limit elevation (dry season river) correction map 

-  Buatlah peta ketebalan gambut baik di atas batas sebaran muka air 

tanah/dry peat depth above drainage limit level (dry season river) map (lihat 

kembali tahapan pengerjaannya pada langkah 7). 



  

Gambar 1.30 Dry peat depth above drainage limit level (dry season river) map 

11. Proses Pembuatan Peta Ketebalan Gambut Di Atas Batas Drainase Musim 

Hujan (Banjir)/Peat Thicknes Map  Above Flood River Drainage Limit Level 

- Untuk tahap pengerjaan pembuatan peta ini hampir sama dengan tahapan 

pembuatan peta pada musim kering (lihat kembali langkah 10); 

  

Gambar 1.31 Drainage Limit Map 

- Untuk mendapatkan drainage limit elevation flood river map didapatkan dari 

hasil penambahan dari flood river elevation map dengan drainage limit map 

(langkah pengerjaan lihat kembali langkah 7); 



  

Gambar 1.32  Drainage limit elevation (flood season river) map 

- Selanjutnya mengkombinasikan antara peat bottom map dengan Peta elevasi 

sebaran muka air tanah batas drainase/ flood season river drainage limit 

elevation map (lihat kembali langkah 8). 

  

Gambar 1.33 Drainage limit elevation (flood season river) correction map 

- Membuat peta ketebalan gambut di atas sebaran muka air tanah batas 

drainase musim hujan/peat thicknes map above drainage limit flood river level 

(lihat kembali tahapan pengerjaannya pada langkah 7). 



 

Gambar 1.34 Dry peat depth above drainage limit level (flood season river) map 

12.  Proses Pembuatan Peta Klasifikasi Sebaran Bulk Density/Bulk Density Map 

Dari klasifikasi sebaran bulk density dilakukan dengan menggunakan plugin 

“Raster Calculator” dengan menggunakan data dasar berupa peta kontur 

ketebalan data gambut yang kemudian diklasifikasikan berdasarkan 

kedalamannya. Dalam hal ini gambut dengan kedalaman 0 s/d 2 m memiliki bulk 

density 0,15 g/cm3, gambut dengan kedalaman 2 s/d 4 m memiliki bulk density 

0,1 g/cm3 dan gambut dengan kedalaman lebih dari 4 m memiliki bulk density 

0,07 g/cm3. Sebelum melangkah kesana bacalah situs berikut: 

http://spatialgalaxy.net/2012/01/25/using-the-qgis-raster-calculator/ dan http://gis-

lab.info/qa/rastercalc-eng.html 

- Klik menu “Raster” > Raster Calculator 

Kemudian buatlah formula dengan mengikuti seperti pada gambar di bawah 

ini.  

1. Ketebalan gambut 0-2 m, nilai BD 0.15 g/cm3 

Gambar di bawah merupakan contoh formula untuk kedalaman 0-2 m 

dengan nilai BD 0,15 g/cm3.  

http://spatialgalaxy.net/2012/01/25/using-the-qgis-raster-calculator/
http://gis-lab.info/qa/rastercalc-eng.html
http://gis-lab.info/qa/rastercalc-eng.html


 

Gambar 1.35 Contoh formula pada “Raster Calculator” dalam 
mengklasifikasikan sebaran bulk density 0.15 g/cm3 

  

Gambar 1.36 Contoh Peta Klasifikasi Sebaran Bulk Density (kedalaman 0-2 m, 
bulk density 0,15 g/cm3) 

2. Ketebalan gambut 2-4 m, nilai BD 0.1 g/cm3 

Selanjutnya dalam pembuatan Peta Bulk Density untuk kedalaman 2-4 m 

dengan nilai BD 0,1 g/cm3. Berikut contoh formula yang digunakan: 



 

Gambar 1.37 Contoh formula pada “Raster Calculator” dalam 
mengklasifikasikan sebaran bulk density 0.15 g/cm3 

  

Gambar 1.38 Contoh Peta Klasifikasi Sebaran Bulk Density (kedalaman 2-4 m, 
bulk density 0,1 g/cm3) 

3. Ketebalan gambut >4 m, nilai BD 0.07 g/cm3 

Selanjutnya dalam pembuatan Peta Bulk Density untuk kedalaman >4 m 

dengan nilai BD 0,07 g/cm3. Berikut contoh formula yang digunakan: 



 

Gambar 1.39 Contoh formula pada “Raster Calculator” dalam 
mengklasifikasikan sebaran bulk density 0.07 g/cm3 

  

Gambar 1.40 Contoh Peta Klasifikasi Sebaran Bulk Density (kedalaman >4 m, bulk 
density 0,1 g/cm3) 

- Setiap klasifikasi sebaran bulk density menghasilkan satu peta sebaran, 

maka perlunya pengabungan dari klasifikasi sebaran bulk density tersebut 

dengan menggunakan “Raster Calculator” dengan cara menambahkan ketiga 

raster tersebut dan akan menghasilkan satu Peta Klasifikasi Sebaran Bulk 

Density (lihat kembali langkah 7). 



 

Gambar 1.41 Peta Klasifikasi Sebaran Bulk Density/Bulk Density Map 

13. Pembuatan Dry Peat Volume Oxidation of Total Peat Map, Dry Peat Volume 

Oxidation above Dry Season River Level Map, Dry Peat Volume Oxidation above 

Drainage Limit Dry Season River level Map, Dry Peat Volume Oxidation above 

Flood Season River Level Map, dan Dry Peat Volume Oxidation above Drainage 

Limit Flood Season River Level Map     

Dalam menghitung volume, data dari dry peat depth of total peat map, dry peat 

depth above dry season river level map, dry peat depth above drainage limit dry 

season river level map, dry peat depth above flood river level map, dan dry peat 

depth above drainage limit flood season river level map harus dikalikan dengan 

luasannya yaitu 100 m x 100 m. Pertanyaannya adalah “kenapa harus dikalikan 

100 m x 100 m ?” Karena ukuran pixel dari peta elevasi sebagai data dasar 

dalam perhitungan memiliki ukuran 100 m x 100 m per pixelnya. Artinya setiap 

kotak kecil atau pixel didalam peta memiliki luasan sebesar 1 ha atau 10.000 m2 

lahan. Sehingga keseluruhan peta volume memiliki satuan m3. 

Dalam perhitungan volume berdasarkan penjelasan di atas dapat dilakukan 

dengan menggunakan “Raster > Raster Calculator” di QGIS 1.8. Perhatikan 

gambar di bawah ini. 



 

Gambar 1.42 Contoh penggunaan “raster calculator” dalam perhitungan volume untuk 
mendapatkan dry peat volume of total peat map 

  

Gambar 1.43 Contoh peta volume gambut untuk gambut keseluruhan/dry peat volume 
of total peat map dalam satuan cm3 

Berikut ini besaran volume gambut di Kawasan Sei. Ahas sebesar: 

Tabel 1.1 Volume Gambut di Kawasan Sei Ahas 

URAIAN Volume Gambut (cm
3
) 

Volume gambut keseluruhan 36070401786831.7 

Volume gambut di atas muka air sungai musim 
kemarau 

32064540356308.2 

Volume gambut di atas drainage limit  (musim 
kemarau) 

27077760768556.2 

Volume gambut di atas muka air banjir sungai  27875916339648.7 

Volume gambut di atas drainage limit (banjir 
sungai) 

21629301131515.3 



Selanjutnya peta volume gambut tersebut dikalikan kembali dengan kandungan oksidasi 

gambut. Untuk besaran kandungan oksidasi gambut di Kawasan Sei. Ahas sebesar 80% 

dengan menggunakan raster calculator. 

 

Gambar 1.44 Contoh peta volume gambut teroksidasi untuk gambut keseluruhan/peat 
volume oxidation of total peat map dalam satuan cm3 

Pada tahapan ini akan menghasilkan beberapa peta, yaitu: 

 Peta volume gambut teroksidasi untuk gambut keseluruhan/peat volume 

oxidation of total peat map; 

 Peta volume gambut teroksidasi untuk di atas muka air sungai musim 

kering/peat volume oxidation above dry season river level map; 

 Peta volume gambut teroksidasi untuk di atas drainage limit/peat volume 

oxidation above drainage limit dry season river level map; 

 Peta volume gambut teroksidasi untuk di atas muka air banjir sungai/peat 

volume oxidation above flood river  level map; 

 Peta volume gambut teroksidasi untuk di atas drainage limit/peat volume 

oxidation above drainage limit flood season river level map. 



Berdasarkan langka-langkah yang telah dijelaskan di atas, didapatkan volume 

gambut teroksidasi di Kawasan Sei. Ahas sebesar: 

Tabel 1.2 Volume Gambut Teroksidasi di Kawasan Sei Ahas 

URAIAN Volume Gambut Teroksidasi (cm
3
) 

Volume Gambut Keseluruhan  28856321927225.0 

Volume Gambut di atas Muka Air Sungai Musim 
Kemarau 

25651632741873.5 

Volume Gambut di atas Drainage Limit  (Musim 
Kemarau) 

21662208945921.5 

Volume Gambut di atas Muka Air Banjir Sungai  22300733447694.8 

Volume Gambut di atas Drainage Limit (Banjir 
Sungai) 

17303441191376.1 

14. Pembuatan Dry Peat Weight of Total Peat Map, Dry Peat Weight above Dry 

Season River Level Map, Dry Peat Weight above Drainage Limit Dry Season 

River Level Map, Dry Peat Weight above Flood River Level Map, dan Dry Peat  

Weight above Drainage Limit Flood Season River Level Map 

Sampai tahap ini peta yang telah dihasilkan adalah: 

 Peta peta klasifikasi sebaran bulk density/bulk density map; 

 Peta volume gambut kering untuk gambut keseluruhan/dry peat volume of 

total peat map; 

 Peta volume ketebalan gambut kering untuk di atas muka air musim 

kering/dry peat volume above dry season river level map. 

 Peta volume gambut kering untuk di atas drainage limit musim kemarau/dry 

peat volume above drainage limit dry season river level map; 

 Peta volume gambut kering untuk di atas muka air banjir/dry peat volume 

above flood river  level map; 

 Peta volume gambut kering untuk di atas drainage limit (musim banjir 

sungai)/dry peat volume above drainage limit flood season river level map. 

Material gambut kering/peat dry weight (gram) sendiri didapatkan dari hasil 

perkalian antara bulk density (g/cm3) dengan volume gambut kering (cm3). 

Berdasarkan rumusan tersebut dapat dianalisis material gambut kering dengan 

menggunakan QGIS dengan peta-peta yang telah dimiliki di atas sebagai data 

input. Tahapan pengerjaannya dapat dilihat di bawah ini: 

 Klik menu “Raster” > Raster Calculator  

 Setelah muncul tampilan “Raster Calculator”, buatlah formula perkalian 

antara Peta Bulk Density dengan salah satu peta volume Gambut Kering 



yang dimiliki (contoh peta yang digunakan adalah Peta Volume Gambut 

Kering untuk Gambut Keseluruhan/dry peat volume of total peat map) untuk 

mendapatkan peta volume material Gambut Kering yang diinginkan (lihat 

kembali pada langkah 7). Perhatikan gambar di bawah: 

 

Gambar 1.45 Contoh penggunaan “raster calculator” dalam perhitungan kandungan 
karbon untuk mendapatkan peat dry weight of total peat map 

 Lalu klik “OK”, maka QGIS akan menghasilkan peta material gambut kering 

untuk gambut keseluruhan/peat dry weight of total peat map yang dapat 

dilihat seperti gambar dibawah ini. 

 

Gambar 1.46 Peta material gambut kering keseluruhan/peat dry weight of total peat 
map 

  



 Berdasarkan langkah di atas, akan menghasilkan beberapa peta yaitu: 

a. Peta material gambut kering untuk gambut keseluruhan/dry peat  weight 

total peat map; 

b. Peta material gambut kering untuk di atas muka air tanah musim 

kemarau/dry peat weight above dry season river level map; 

c. Peta material gambut kering untuk di atas batas drainase musim 

kemarau/dry peat weight above drainage limit dry season river level map; 

d. Peta material gambut kering untuk di atas muka air banjir/peat dry weight 

above flood river level map; 

e. Peta material gambut kering untuk di atas muka air musim banjir/peat dry 

weight above drainage limit flood season river level map. 

Material gambut kering dihasilkan berupa peta yang merupakan volume material 

gambut kering disetiap pixelnya, untuk mengetahui material gambut kering 

keseluruhan suatu kawasan dapat dilakukan dengan 2 cara yaitu: 

a) Dengan menggunakan “Zonal Statistics” pada QGIS 

- Buatlah layer baru, klik menu “Layer” > New > New Shapefile Layer; pilih 

polygon, samakan CRS ke WGS 84/UTM zone 50s, ikuti contoh setting 

lainnya seperti pada gambar di bawah > OK. 

 

Gambar 1.47 Contoh setting layer baru 

- Buatlah zona yang akan dianalisis, klik “Toggle Editing” > Add Feature > 

lalu gambarlah kawasan yang ingin di analisis material gambut keringnya 

> isi bebas id “Attribute” > Save > Toggle Editing.  



Posisikan koordinat Xmin Ymin dan Xmax, Ymax sesuai dengan ukuran 

peta yang sudah dibuat.  

 

Gambar 1.48 Zona yang telah selesai digambar yang berfungsi sebagai batas 
menganalisis material gambut kering keseluruhan suatu kawasan 

- Analisis material gambut kering keseluruhan suatu kawasan, klik menu 

“Raster” > Zonal Statistics > Zonal Statistics. Zonal statistics ini berfungsi 

untuk menentukan statistik data yang ada didalam zona yang dibatasi 

dengan layer .shp yang telah dibuat. 

 

Gambar 1.49 Cara mengaktifkan “Zonal Statistics” 

- Selanjutnya akan muncul tampilan “Dialog”, lalu pada “Raster Layer” pilih 

layer yang ingin dianalisis (Peat dry weight Peat Total Valume Map). 

Kemudian shape layer yang membatasinya pada “Polygon Layer 

Containing The Zones”, untuk output column prefix bebas saja untuk 



penamaan id saja, dalam hal ini diisi angka 1 (satu). Lalu tekan OK 

setelah itu. Perhatikan gambar berikut ini. 

 

Gambar 1.50 Tampilan “Dialog” dan cara pengisiannya 

- Kemudian klik kanan pada shape layer (Mask Analysis) > Open Attribute 

Table.  

 

Gambar 1.51 Cara menampilkan hasil analisis material kering keseluruhan 

- Hasilnya dapat dilihat , semua data statistik yang diinginkan dalam hal ini 

adalah total seluruh material Gambut Kering. Lihat gambar berikut ini: 



 

Gambar 1.52 Hasil analisis material gambut kering untuk gambut keseluruhan 

Kemudian hasil di atas dapat disalin ke Microsoft Excel. Berdasarkan 

analisis ini didapatkan bahwa Material Gambut Kering untuk Gambut 

Keseluruhan adalah 2774993867289.98 gram (lihat gambar dengan 

kolom berwarna hijau). 

- Untuk analisis material Gambut Kering yang lainnya dapat dilakukan 

langsung dengan “Zonal Statistics” tanpa membuat zona kembali, tapi 

dengan catatan pada saat dialog pengisian output column prefix harus 

berbeda dengan yang lainnya agar tidak menimbulkan kebingungan. 

b) Dengan Excel 

- Mengubah format data peta material Gambut Kering ke dalam bentuk data 

dengan menggunakan “Translate [Convert Format]”. Klik menu “Raster” > 

Conversion > Translate [Convert Format]; 



 

Gambar 1.53 Cara mengaktifkan “Translate [Convert Format]” 

- Pilih layer yang akan dirubah kedalam format file .asc; 

 

Gambar 1.54 Cara mengubah format file dari .shp ke .asc 

- File layer yang berformat file .asc siap untuk digunakan. 

- Selanjutnya buka “Microsoft Excel” > Klik tab “Data” > From Text > 

ubahlah format file menjadi “All Files” > pilih file yang ingin dibuka > 

import. Setelah itu akan tampil “Text Import Wizard”, langsung klik “next”. 

Lalu data tersebut dipilah agar sesuai pada kolom yang benar (lakukan 

dengan teliti agar angka data tidak masuk ke dalam kolom yang lain). 

Selanjutnya tekan “Finish”, maka data material gambut kering per pixel 

akan tampil. Perhatikan gambar berikut ini. 



 

Gambar 1.55 Data material Gambut Kering dalam format file .xlsx 

- Sebelum menghitung total material gambut keringnya, terlebih dahulu di 

pilah lagi data mana saja yang akan digunakan atau tidak digunakan. 

- Setelah didapat, ditotal langsung dengan menggunakan sum dan 

didapatkan bahwa Material Gambut Kering untuk Gambut Keseluruhan 

adalah  2774993867289.98 gram. 

Berdasarkan langka-langkah yang telah dijelaskan di atas, didapatkan material 

Gambut Kering sebesar: 

Tabel 1.3 Material Gambut Kering di Kawasan Sei Ahas 

URAIAN 
Material Gambut Kering (Mton) 

Manual Excel QGIS 

Gambut Keseluruhan 2.775 2.775 

Gambut di atas Muka Air 
Sungai Musim Kemarau 

2.481 2.481 

Gambut di atas Drainage 
limit (Musim Kemarau) 

2.113 2.113 

Gambut di atas Muka Air 
Banjir Sungai 

2.157 2.157 

Gambut di atas Drainage 
Limit (Banjir Sungai) 

1.677 1.677 

15. Perhitungan Volume Karbon Gambut 

Volume Karbon Gambut didapatkan dari hasil perkalian antara volume material 

Gambut Kering dengan kandungan karbon gambut dangkal (carbon content 

shallow peat). Nilai kandungan karbon gambut dangkal sebesar 50% dan 55%. 

Untuk perhitungan berikut ini menggunakan software Microsoft Excel. Berikut 

hasil perhitungannya:  

  



Tabel 1.4 Volume Karbon Gambut di Kawasan Sei Ahas 

URAIAN 
MATERIAL GAMBUT 

KERING 
(Mton) 

VOLUME KARBON GAMBUT 
(Mton) 

CARBON CONTENT 
SHALLOW PEAT (50%) 

CARBON CONTENT 
SHALLOW PEAT (55%) 

Gambut Keseluruhan 2.775 1.387 1.526 

Gambut di atas Muka 
Air Sungai Musim 
Kemarau 

2.481 1.240 1.365 

Gambut di atas 
Drainage limit 
(Musim Kemarau) 

2.113 1.057 1.162 

Gambut di atas Muka 
Air Banjir Sungai 

2.157 1.079 1.186 

Gambut di atas 
Drainage Limit 
(Banjir Sungai) 

1.677 0.839 0.923 

16.  Perhitungan Emisi Karbon 

Karbon yang teroksidasi memiliki nama unsur yaitu karbon dioksida (CO2). 

Diketahui bahwa total unsur atom dari CO2 adalah 44 (dimana C = 12.0107 g; O 

= 15.9994 g), sehingga diketahui bahwa ratio karbon pada gas karbon dioksida 

(CO2) sebesar 3,66. Sehingga dengan rasio ini digunakan untuk mengetahui 

akan besaran emisi karbon dari karbon teroksidasi yang telah hitung pada 

langkah 15. Caranya adalah dengan mengalikan nilai karbon teroksidasi dengan 

rasio karbonnya yaitu 3,66. Berikut merupakan hasil dari perhitungannya: 

Tabel 1.5 Emisi karbon di Kawasan Sei Ahas 

URAIAN 

MATERIAL 
GAMBUT 
KERING 
(Mton) 

VOLUME KARBON GAMBUT 
(Mton) 

EMISI KARBON 
(Mton) 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

Gambut keseluruhan 2.775 1.387 1.526 5.087 5.596 

Gambut di atas muka 
air sungai musim 
kemarau 

2.481 1.240 1.365 4.548 5.003 

Gambut di atas 
drainage limit (musim 
kemarau) 

2.113 1.057 1.162 3.874 4.262 

Gambut di atas muka 
air banjir sungai  

2.157 1.079 1.186 3.955 4.350 

Gambut di atas 
drainage limit (banjir 

sungai) 

1.677 0.839 0.923 3.075 
 

3.383 



17. Perhitungan Kecepatan Penurunan Gambut, Waktu Penurunan Karbon dan Laju 

Emisi Karbon di Kawasan Sei. Ahas (Kondisi Tidak Ada Bendung dan Tanpa 

Penghutanan Kembali) 

 Hitunglah kecepatan penurunan gambut (subsidence rate) pada suatu 

kawasan. Dengan kondisi tidak ada bendung dan tanpa penghutanan 

kembali, maka persamaan yang digunakan adalah: 

     

Water depth average (WD) diasumsikan sebesar 0,4 m, maka kecepatan 

penurunan gambutnya di Kawasan Sei. Ahas 

Subsidence rate  = 1,5 – 4,98WD 

 = 1,5 – 4,98 (-0,4) 

 = 3,492 cm/tahun 

 Selanjutnya hitunglah waktu penurunan gambut yang dibutuhkan pada suatu 

kawasan. Terlebih dahulu harus diketahui ketebalan gambut maksimum pada 

suatu kawasan baik dalam kondisi Drainage Limit, flood river level, dan dry 

season river level. Persamaan yang digunakan adalah: 

 

Untuk mengetahui ketebalan gambut maksimum pada suatu kawasan, akan 

digunakan QGIS. Berikut langkah-langkah pengerjaannya: 

 Langkah pertama digunakan “vector grid” untuk peta ketebalan gambut 

dan pilih vector grid sesuai dengan kawasan studi yang akan dianalisis; 

 Ubahlah hasil vector grid tesebut menjadi polygon centroids; 

 Ubahlah data polygon centroids menjadi data ketebalan gambut dengan 

menggunakan points sampling tool; 

 Klik menu “Vector” > Analysis Tools > Basic Statistics; 



 

Gambar 1.56 Cara mengaktifkan “Basic Statistics” 

 Lalu pilihlah input vector layer yang ingin digunakan, lalu klik OK; 

 

Gambar 1.57 Tampilan “Basic Statistics” 

 Setelah itu basic statistics akan memperoses dan selanjutnya akan 

menampilkan hasil akan statistik data ketebalan yang di-input tadi. Pada 

basic statistics tersebut akan menampilkan mean, maka itulah merupakan 

ketebalan gambut yang rata-rata pada suatu kawasan. 

 

Gambar 1.58 Statistik ketebalan gambut pada suatu kawasan 



Berdasarkan gambar di atas didapatkan bahwa ketebalan gambut 

maksimum sebesar 1.876 m = 187.6 cm (Average Amount of Peat above 

Drainage Limit Level). 

Selanjutnya cara menghitung waktu penurunan gambut untuk Drainage Limit 

level: 

 

 

Berikut waktu penurunan gambut di Kawasan Sei. Ahas: 

Tabel 1.6 Waktu penurunan gambut di Kawasan Sei Ahas 

URAIAN 
KETEBALAN 

GAMBUT RERATA 
(cm) 

WAKTU PENURUNAN 
GAMBUT 

(tahun) 

Gambut Keseluruhan 187.6 54 

Gambut di atas Muka Air Sungai Musim 
Kemarau 

166.8 48 

Gambut di atas Drainage limit (Musim 
Kemarau) 

140.9 40 

Gambut di atas Muka Air Banjir Sungai 144.7 41 

Gambut di atas Drainage Limit (Banjir 
Sungai) 

112.3 32 

 Untuk langkah berikutnya adalah menghitung laju emisi karbon pada suatu 

kawasan yaitu dengan cara membagi emisi karbon dengan waktu penurunan 

gambut. Berikut ini persamaannya adalah: 

 

Contoh perhitungan laju emisi karbon untuk Drainage Limit level: 

 

 

 

  



Berikut laju emisi karbon di Kawasan Sei. Ahas: 

Tabel 1.7 Laju emisi karbon di Kawasan Sei Ahas 

URAIAN 

EMISI KARBON 
(Mton) 

LAJU EMISI KARBON 
(Mton/tahun) 

CARBON 
CONTENT 

SHALLOW PEAT 
(50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 

SHALLOW PEAT 
(55%) 

Gambut Keseluruhan 5.087 5.596 0.095 0.104 

Gambut di atas Muka Air 
Sungai Musim Kemarau 

4.548 5.003 0.095 0.105 

Gambut di atas Drainage 
limit (Musim Kemarau) 

3.874 4.262 0.096 0.106 

Gambut di atas Muka Air 
Banjir Sungai 

3.955 4.350 0.095 0.105 

Gambut di atas Drainage 
Limit (Banjir Sungai) 

3.075 
 

3.383 0.096 0.105 

 Setelah didapatkan laju emisi karbon emisi karbon, maka dapat dilakukan 

prediksi besaran emisi karbon untuk 25 tahun, 50 tahun dan 100 tahun. 

Berikut ini besaran emisi karbon di Kawasan Sei. Ahas: 

Tabel 1.8 Emisi karbon di Kawasan Sei Ahas 

URAIAN 

EMISI KARBON (Mton) 

25 tahun 50 tahun 100 tahun 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT 
(50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT 
(55%) 

Gambut 
Keseluruhan 

2.375 2.605 4,736 (50 
thn)  

5.210 (50 
thn) 

5,087 (54 
thn)  

5.596 (54 
thn) 

Gambut di 
atas Muka Air 
Sungai Musim 
Kemarau 

2.380 2.618 4,548 (48 
thn)  

5.003 (48 
thn)  

- - 

Gambut di 
atas Drainage 
limit (Musim 
Kemarau) 

2.401 2.641 3,874 (40 
thn)  

4.262 (40 
thn)  

- - 

Gambut di 
atas Muka Air 
Banjir Sungai 

2.386 2,624 3,955 (41 
thn)  

4.350 (41 
thn)  

- - 

Gambut di 
atas Drainage 
Limit (Banjir 
Sungai) 

2.390 2.629 3,075 (32 
thn)  

3.383  (32 
thn)  

- - 

 

18. Perhitungan Kecepatan Penurunan Gambut, Waktu Penurunan Karbon dan Laju 

Emisi Karbon di Kawasan Sei. Ahas (Kondisi Ada 3 Bendung dan Tanpa 

Penghutanan Kembali) 

- Hitunglah kecepatan penurunan gambut (subsidence rate) pada suatu 

kawasan. Persamaan yang digunakan sama dengan langkah 17, akan tetapi 

nilai WD tereduksi sebesar menjadi 50% karena dipengaruhi adanya 3 

bendung. Berikut persamaan yang digunakan adalah: 



 

Pada langkah 17 diketahui bahwa water depth average (WD) diasumsikan 

sebesar 0,4 m, karena adanya 3 saluran maka WD tereduksi sebanyak 50% 

sehingga menjadi 0,2 m. Berikut merupakan contoh perhitungan kecepatan 

penurunan: 

Subsidence rate = 1,5 – 4,98WD 

 = 1,5 – 4,98 (-0,2) 

 = 2,496 cm/tahun 

- Untuk perhitungan waktu penurunan gambut, dapat mengikuti langkah 17 di 

atas. Berikut waktu penurunan gambut di Kawasan Sei. Ahas: 

Tabel 1.9  Waktu penurunan gambut di Kawasan Sei Ahas 

URAIAN 

MATERIAL 
GAMBUT 
KERING 
(Mton) 

VOLUME KARBON GAMBUT 
(Mton) 

EMISI KARBON 
(Mton) 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

Gambut 
keseluruhan 

2.775 1.387 1.526 5.087 5.596 

Gambut di atas 
muka air sungai 
musim kemarau 

2.481 1.240 1.365 4.548 5.003 

Gambut di atas 
drainage limit 

(musim kemarau) 

2.113 1.057 1.162 3.874 4.262 

Gambut di atas 
muka air banjir 
sungai  

2.157 1.079 1.186 3.955 4.350 

Gambut di atas 
drainage limit 
(banjir sungai) 

1.677 0.839 0.923 3.075 
 

3.383 

 

  



- Untuk langkah berikutnya adalah menghitung laju emisi karbon pada suatu 

kawasan dapat mengikuti langkah 17. Berikut merupakan hasil laju emisi 

karbon di Kawasan Sei Ahas: 

Tabel 1.10 Laju emisi karbon di Kawasan Sei Ahas 

URAIAN 

EMISI KARBON 
(Mton) 

LAJU EMISI KARBON 
(Mton/tahun) 

CARBON 
CONTENT 

SHALLOW PEAT 
(50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 

SHALLOW PEAT 
(55%) 

Gambut Keseluruhan 5.087 5.596 0.068 0,074 

Gambut di atas Muka Air 
Sungai Musim Kemarau 

4.548 5.003 0.068 0,075 

Gambut di atas Drainage 
limit (Musim Kemarau) 

3.874 4.262 0.069 0,076 

Gambut di atas Muka Air 
Banjir Sungai 

3.955 4.350 0.068 0,075 

Gambut di atas Drainage 
Limit (Banjir Sungai) 

3.075 
 

3.383 0.068 0,075 

 Selanjutnya prediksi besaran emisi karbon 25, 50 dan 100 tahun. dengan didapatkan 

hasil Berikut ini besaran emisi karbon 25, 50 dan 100 tahun di Kawasan Sei. Ahas: 

Tabel 1.11 Emisi karbon di Kawasan Sei Ahas 

URAIAN 

EMISI KARBON (Mton) 

25 tahun 50 tahun 100 tahun 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT 
(50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT 
(55%) 

Gambut 
Keseluruhan 

1.693 1.862 3.385 (50 
thn) 

3.724 (50 
thn) 

6.771 (75 
thn) 

5.596 (75 
thn) 

Gambut di 
atas Muka Air 
Sungai Musim 
Kemarau 

1.701 1.871 3.403 (50 
thn) 

3.743 (50 
thn) 

6.805 (67 
thn) 

5.003 (67 
thn) 

Gambut di 
atas Drainage 
limit (Musim 
Kemarau) 

1.716 1.888 3.432 (50 
thn) 

3.775 (50 
thn) 

6.864 (56 
thn) 

4.262 (56 
thn) 

Gambut di 
atas Muka Air 
Banjir Sungai 

1.705 1.876 3.410 (50 
thn) 

3.751 (50 
thn) 

6.821 (58 
thn) 

4.350 (58 
thn) 

Gambut di 
atas Drainage 
Limit (Banjir 
Sungai) 

1.708 1.879 3.075 (45 
thn) 

3.383 (45 
thn) 

- - 

19. Perhitungan Kecepatan Penurunan Gambut, Waktu Penurunan Karbon dan Laju 

Emisi Karbon di Kawasan Sei. Ahas (Kondisi Ada 3 Bendung dan Penghutanan 

Kembali) 

- Dengan kondisi adanya 3 bendung dan penghutanan kembali, terdapat ada 2 

(dua) buah persamaan yaitu: 

 



 

Pada langkah 17 diketahui bahwa water depth average (WD) diasumsikan 

sebesar 0,4 m, karena adanya 3 saluran maka WD tereduksi sebanyak 50% 

sehingga menjadi 0,2 m. Berikut merupakan contoh perhitungan kecepatan 

penurunan pada persamaan pertama: 

Subsidence rate  = 0,41 – 6,04WD 

 = 0,41 – 6,04 (0,2) 

 = 1,618 cm/tahun 

Sedangkan dalam persamaan kedua water depth average (WD) diasumsikan 

sebesar 0,4 m. Berikut merupakan contoh perhitungan kecepatan penurunan: 

Subsidence rate  = 7,06WD 

 = 7,06 (0,4) 

 = 2,824 cm/tahun 

Berdasarkan hasil perhitungan kecepatan penurunan dari kedua persamaan 

di atas, didapatkan bahwa pada persamaan pertama kecepatan 

penurunannya lebih logis dibandingkan persamaan kedua. Sehingga hasil 

kecepatan penurunan yang digunakan adalah 1,618 cm/tahun. 

- Untuk perhitungan waktu penurunan gambut, dapat mengikuti langkah 17 di 

atas. Berikut waktu penurunan gambut di Kawasan Sei. Ahas: 

Tabel 1.12 Waktu penurunan gambut di Kawasan Sei Ahas 

URAIAN 
KETEBALAN 

GAMBUT MAKSIMUM 
(cm) 

WAKTU PENURUNAN 
GAMBUT 

(tahun) 

Gambut Keseluruhan 187.6 116 

Gambut di atas Muka Air Sungai Musim 
Kemarau 

166.8 103 

Gambut di atas Drainage limit (Musim 
Kemarau) 

140.9 87 

Gambut di atas Muka Air Banjir Sungai 144.7 89 

Gambut di atas Drainage Limit (Banjir 
Sungai) 

112.3 69 

- Untuk langkah berikutnya adalah menghitung laju emisi karbon pada suatu 

kawasan dapat mengikuti langkah 17. Berikut merupakan hasil laju emisi 

karbon di Kawasan Sei Ahas: 

Tabel 1.13 Laju emisi karbon di Kawasan Sei Ahas 



URAIAN 

EMISI KARBON 
(Mton) 

LAJU EMISI KARBON 
(Mton/tahun) 

CARBON 
CONTENT 

SHALLOW PEAT 
(50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 

SHALLOW PEAT 
(55%) 

Gambut Keseluruhan 5.087 5.596 0.044 0.048 

Gambut di atas Muka Air 
Sungai Musim Kemarau 

4.548 5.003 0.044 0.049 

Gambut di atas Drainage 
limit (Musim Kemarau) 

3.874 4.262 0.044 0.049 

Gambut di atas Muka Air 
Banjir Sungai 

3.955 4.350 0.044 0.049 

Gambut di atas Drainage 
Limit (Banjir Sungai) 

3.075 
 

3.383 0.044 0.049 

 

- Selanjutnya prediksi besaran emisi karbon 25 tahun, 50 tahun dan 100 tahun. 

dengan didapatkan hasil Berikut ini besaran emisi karbon 25 tahun, 50 tahun 

dan 100 tahun di Kawasan Sei. Ahas: 

Tabel 1.14 Emisi karbon di Kawasan Sei Ahas 

URAIAN 

EMISI KARBON (Mton) 

25 tahun 50 tahun 100 tahun 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT 
(50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT 
(55%) 

Gambut 
Keseluruhan 

1.097 1.207 2.194 2.414 4.389 (100 
thn) 

4.828 (100 
thn) 

Gambut di 
atas Muka Air 
Sungai Musim 
Kemarau 

1.103 1.313 2.206 2.426 4.411 (100 
thn) 

4.852 (100 
thn) 

Gambut di 
atas Drainage 
limit (Musim 
Kemarau) 

1.112 1.224 2.225 2.447 3.874 (87 
thn) 

4.262 (87 
thn) 

Gambut di 
atas Muka Air 
Banjir Sungai 

1.105 1.216 2.211 2.432 3.955 (89 
thn) 

4.350 (89 
thn) 

Gambut di 
atas Drainage 
Limit (Banjir 
Sungai) 

1.107 1.218 2.215 2.436 3.075 (69 
thn) 

3.383 (69 
thn) 

20. Perhitungan Kecepatan Penurunan Gambut, Waktu Penurunan Karbon dan Laju 

Emisi Karbon di Kawasan Sei. Ahas (Kondisi Tidak Ada Bendung, Tanpa 

Penghutanan Kembali dan Adanya Kebakaran) 

- Hitunglah perhitungan kecepatan penurunan gambut 

Berdasarkan peta sebaran kebakaran lahan gambut di Kawasan Sei. Ahas 

tahun 2001-2009, diketahui bahwa adanya 54 titik api dari 27 titik kawasan 

Sei Ahas. Sehingga kalau dirata-ratakan bahwa adanya 2,19 titik api per 

kawasan (2,19 fires/cells) selama 9 tahun (0,243 fires/cells year). 

Diasumsikan setiap 1 titik api terjadi penurunan lahan gambut sebesar 10 



cm/tahun. Dengan kondisi tidak adanya saluran, tanpa penghutanan kembali 

dan terjadi kebakaran, maka persamaan yang digunakan adalah: 

 

Berikut merupakan contoh perhitungan kecepatan penurunan gambut: 

Subsidence rate  = 1,5 – 4,98WD + Annual Average Fires 

 = 0,41 – 6,04 (-0,4) + (0,243 10) 

 = 5,920 cm/tahun 

- Untuk perhitungan waktu penurunan gambut, dapat mengikuti langkah 17 di 

atas. Berikut waktu penurunan gambut di Kawasan Sei. Ahas: 

Tabel 1.15 Waktu penurunan gambut di Kawasan Sei Ahas 

URAIAN 
Ketebalan Gambut 

Maksimum 
(cm) 

Waktu Penurunan 
Gambut 
(tahun) 

Gambut Keseluruhan 187.6 32 

Gambut di atas Muka Air Sungai Musim 
Kemarau 

166.8 28 

Gambut di atas Drainage limit (Musim 
Kemarau) 

140.9 24 

Gambut di atas Muka Air Banjir Sungai 144.7 24 

Gambut di atas Drainage Limit (Banjir 
Sungai) 

112.3 19 

- Untuk langkah berikutnya adalah menghitung laju emisi karbon pada suatu 

kawasan dapat mengikuti langkah 17. Berikut merupakan hasil laju emisi 

karbon di Kawasan Sei Ahas: 

Tabel 1.16 Laju emisi karbon di Kawasan Sei Ahas 

URAIAN 

EMISI KARBON 
(Mton) 

LAJU EMISI KARBON 
(Mton/tahun) 

CARBON 
CONTENT 

SHALLOW PEAT 
(50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 

SHALLOW PEAT 
(55%) 

Gambut Keseluruhan 5.087 5.596 0.161 0.177 

Gambut di atas Muka Air 
Sungai Musim Kemarau 

4.548 5.003 0.161 0.178 

Gambut di atas Drainage 
limit (Musim Kemarau) 

3.874 4.262 0.163 0.179 

Gambut di atas Muka Air 
Banjir Sungai 

3.955 4.350 0.162 0.178 

Gambut di atas Drainage 
Limit (Banjir Sungai) 

3.075 
 

3.383 0.162 0.178 

 

- Selanjutnya prediksi besaran emisi karbon 25, 50 dan 100 tahun dengan 

didapatkan hasil berikut ini besaran emisi karbon 25, 50 dan 100 tahun di 

Kawasan Sei. Ahas: 



Tabel 1.17 Emisi karbon di Kawasan Sei Ahas 

URAIAN 

EMISI KARBON (Mton) 

25 tahun 50 tahun 100 tahun 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT (55%) 

CARBON 
CONTENT 
SHALLOW 

PEAT 
(50%) 

CARBON 
CONTENT 
SHALLOW 

PEAT 
(55%) 

Gambut 
Keseluruhan 

4.015 (25 
thn) 

4.416 (25 
thn) 

8.832 (32 
thn) 

2.414 - - 

Gambut di 
atas Muka Air 
Sungai Musim 
Kemarau 

4.035 (25 
thn) 

4.439 (25 
thn) 

8.877 (28 
thn) 

2.426 - - 

Gambut di 
atas Drainage 
limit (Musim 
Kemarau) 

3.874 (24 
thn) 

4.262 (24 
thn) 

- - - - 

Gambut di 
atas Muka Air 
Banjir Sungai 

3.955 (24 
thn) 

4.350 (24 
thn) 

- - - - 

Gambut di 
atas Drainage 
Limit (Banjir 
Sungai) 

3.075 (19 
thn) 

3.383 (19 
thn) 

- - - - 

21. Perhitungan Total Laju Emisi Karbon dan Emisi Karbon yang Dihasilkan pada 

Tahun Pertama Sampai pada Tahun ke-50 di Kawasan Sei. Ahas (Kondisi 

Alamiah Tanpa Rehabilitasi, Kondisi Pengembangan Lahan Perkebunan, Kondisi 

Adanya Bendung, Kondisi Adanya Bendung dan Penghutanan Kembali) 

A. Kondisi Alamiah Tanpa Rehabilitasi (Actual Situation) 

- Hitunglah cadangan karbon awal (initial carbon stock); 

Initial Carbon Stock  = Peat Volume*Carbon Content*BD*Carbon Ratio 

 = 36070401.79*50%*0.15*3.67 

 = 6.60 Mton CO2 

- Siapkan parameter lainnya yang diperlukan, yaitu: 

a. Luas wilayah (area – 19.06 Mm2); 

b. Elevasi lahan gambut awal rerata (initial average peat surface level – 

5.065 m); 

c. Kedalaman saluran awal rerata (initial canal bottom depth – 1.33 m); 

d. Elevasi muka air musim kering (dry season river level – 0.99 m); 

e. Kandungan karbon gambut dangkal (carbon content shallow peat – 

50%); 

f. Kandungan oksidasi karbon gambut (carbon content oxidation – 80%); 
g. Bulk density karbon kering (dry bulk density – 0.15 g/cm3); 



Dikarenakan ketebalan gambut pada kawasan studi memiliki rata-rata 

sebesar 1.876 m, sehingga untuk ketebalan 0-2 m memiliki nilai bulk 

density sebesar 0.15 g/cm3. 

h. Rasio karbon (carbon ratio – 3.67); 

i. Kedalaman air tanah awal (ground water depth start – 0.4 m) 

- Hitunglah elevasi air tanah minimum (ground water level minimum - m); 

GWL minimum (m) = initial average peat surface level – initial canal 

bottom depth 

 = 5.065 – 1.327 

 = 3.74 m 

- Tentukan kedalaman air tanah akhir (ground water depth end – 0,0 m); 

- Hitunglah laju penurunan gambut awal (subsidence start – m/y); 

Subsidence start (m/y)  =  0.015+0.0498*GWD start 

 =  0.015+(0.0498*0.4) 

 =  0.035 m/y 

- Hitunglah laju penurunan gambut akhir (subsidence end – m/y); 

Subsidence end (m/y)  =  0.015+0.0498*GWD end 

 =  0.015+(0.0498*0.0) 

 =  0.015 m/y 

  



- Langkah selanjutnya hitunglah perkiraan karbon emisi setiap tahunnya selama 50 tahun kedepan. Berikut merupakan 

hasil perhitungannya; 

Tabel 1.18 Emisi Karbon di Kawasan Sei Ahas Selama 50 Tahun (Actual Situation) 

Peat stock

Average 

Surface 

Level

GWL GWD Subsidence Emission

(MtonCO2) (m) (m) (m) (m) (MtonCO2/y)

0 6.60 5.07 4.67 0.40 0.035 0.147

1 6.45 5.03 4.63 0.40 0.035 0.147

2 6.31 5.00 4.60 0.40 0.035 0.147

3 6.16 4.96 4.56 0.40 0.035 0.147

4 6.01 4.93 4.53 0.40 0.035 0.147

5 5.87 4.89 4.49 0.40 0.035 0.147

6 5.72 4.86 4.46 0.40 0.035 0.147

7 5.57 4.82 4.42 0.40 0.035 0.147

8 5.43 4.79 4.39 0.40 0.035 0.147

9 5.28 4.75 4.35 0.40 0.035 0.147

10 5.13 4.72 4.32 0.40 0.035 0.147

11 4.99 4.68 4.28 0.40 0.035 0.147

12 4.84 4.65 4.25 0.40 0.035 0.147

13 4.69 4.61 4.21 0.40 0.035 0.147

14 4.55 4.58 4.18 0.40 0.035 0.147

15 4.40 4.54 4.14 0.40 0.035 0.147

16 4.26 4.51 4.11 0.40 0.035 0.147

17 4.11 4.47 4.07 0.40 0.035 0.147

18 3.96 4.44 4.04 0.40 0.035 0.147

19 3.82 4.40 4.00 0.40 0.035 0.147

20 3.67 4.37 3.97 0.40 0.035 0.147

21 3.52 4.33 3.93 0.40 0.035 0.147

22 3.38 4.30 3.90 0.40 0.035 0.147

23 3.23 4.26 3.86 0.40 0.035 0.147

24 3.08 4.23 3.83 0.40 0.035 0.147

25 2.94 4.19 3.79 0.40 0.035 0.147

26 2.79 4.16 3.76 0.40 0.035 0.147

27 2.64 4.12 3.74 0.38 0.034 0.143

28 2.50 4.09 3.74 0.35 0.032 0.136

29 2.36 4.06 3.74 0.32 0.031 0.129

30 2.23 4.02 3.74 0.29 0.029 0.123

31 2.11 4.00 3.74 0.26 0.028 0.117

32 1.99 3.97 3.74 0.23 0.026 0.111

33 1.88 3.94 3.74 0.20 0.025 0.105

34 1.78 3.92 3.74 0.18 0.024 0.100

35 1.68 3.89 3.74 0.15 0.023 0.095

36 1.58 3.87 3.74 0.13 0.022 0.090

37 1.49 3.85 3.74 0.11 0.020 0.086

38 1.41 3.83 3.74 0.09 0.019 0.082

39 1.32 3.81 3.74 0.07 0.018 0.078

40 1.25 3.79 3.74 0.05 0.018 0.074

41 1.17 3.77 3.74 0.03 0.017 0.070

42 1.10 3.76 3.74 0.02 0.016 0.067

43 1.04 3.74 3.74 0.00 0.015 0.063

44 0.97 3.72 3.72 0.00 0.015 0.063

45 0.91 3.71 3.71 0.00 0.015 0.063

46 0.85 3.69 3.69 0.00 0.015 0.063

47 0.78 3.68 3.68 0.00 0.015 0.063

48 0.72 3.66 3.66 0.00 0.015 0.063

49 0.66 3.65 3.65 0.00 0.015 0.063

50 0.60 3.63 3.63 0.00 0.015 0.063

Year

 

  



- Hitunglah total emisi karbon selama 50 tahun (total carbon emission – 

Mton CO2/year); 

Total carbon emission (Mton CO2/year)  = 5.28 Mton CO2/year 

- Diketahui emisi karbon tahun pertama (carbon emission year 1 – Mton 

CO2/year); 

Carbon emission year 1 (Mton CO2/year) = 0.147 Mton CO2/year 

- Diketahui emisi karbon tahun ke-50 (carbon emission year 50 – Mton 

CO2/year). 

Carbon emission year 50 (Mton CO2/year) = 0.063 Mton CO2/year 

B. Kondisi Pengembangan Perkebunan (Autonomous Development - 

Plantation) 

- Hitunglah cadangan karbon awal (initial carbon stock); 

Initial Carbon Stock  = Peat Volume*Carbon Content*BD*Carbon Ratio 

 = 36070401.79*50%*0.15*3.67 

 = 6.60 Mton CO2 

- Siapkan parameter lainnya yang diperlukan, yaitu: 

a. Luas wilayah (area – 19.06 m2); 

b. Elevasi lahan gambut awal rerata (initial average peat surface level 

– 5.065 m); 

c. Kedalaman saluran awal rerata (initial canal bottom depth – 1.33 m); 

d. Elevasi muka air musim kering (dry season river level – 0.99 m); 

e. Kandungan karbon gambut dangkal (carbon content shallow peat – 

50%); 

f. Kandungan oksidasi karbon gambut (carbon content oxidation – 

80%); 

g. Bulk density karbon kering (dry bulk density – 0.15 g/cm3); 

Dikarenakan ketebalan gambut pada kawasan studi memiliki rata-

rata sebesar 1.876 m, sehingga untuk ketebalan 0-2 m memiliki nilai 

bulk density sebesar 0.15 g/cm3. 

h. Rasio karbon (carbon ratio – 3.67); 

i. Kedalaman air tanah awal (ground water depth start – 0.8 m) 

- Hitunglah elevasi air tanah minimum (ground water level minimum - m); 



Untuk scenario ini elevasi air tanah minimum sama dengan elevasi 

muka air musim kering, yaitu 0.99 m. 

- Tentukan kedalaman air tanah akhir (ground water depth end – 0,0 m); 

- Hitunglah laju penurunan gambut awal (subsidence start – m/y); 

Subsidence start (m/y)  =  0.015+0.0498*GWD start 

 =  0.015+(0.0498*0.8) 

 =  0.055 m/y 

- Hitunglah laju penurunan gambut akhir (subsidence end – m/y); 

Subsidence end (m/y)  =  0.015+0.0498*GWD end 

 =  0.015+(0.0498*0.0) 

 =  0.015 m/y 

  



- Langkah selanjutnya hitunglah perkiraan karbon emisi setiap tahunnya selama 50 tahun kedepan. Berikut merupakan 

hasil perhitungannya; 

Tabel 1.19 Emisi Karbon di Kawasan Sei Ahas Selama 50 Tahun (Autonomous Development - Plantation) 

Peat stock

Average 

Surface 

Level

GWL GWD Subsidence Emission

(MtonCO2) (m) (m) (m) (m) (MtonCO2/y)

0 6.60 5.07 4.27 0.80 0.055 0.230

1 6.37 5.01 4.21 0.80 0.055 0.230

2 6.14 4.96 4.16 0.80 0.055 0.230

3 5.91 4.90 4.10 0.80 0.055 0.230

4 5.68 4.85 4.05 0.80 0.055 0.230

5 5.45 4.79 3.99 0.80 0.055 0.230

6 5.22 4.74 3.94 0.80 0.055 0.230

7 4.99 4.68 3.88 0.80 0.055 0.230

8 4.76 4.63 3.83 0.80 0.055 0.230

9 4.53 4.57 3.77 0.80 0.055 0.230

10 4.30 4.52 3.72 0.80 0.055 0.230

11 4.07 4.46 3.66 0.80 0.055 0.230

12 3.84 4.41 3.61 0.80 0.055 0.230

13 3.61 4.35 3.55 0.80 0.055 0.230

14 3.38 4.30 3.50 0.80 0.055 0.230

15 3.15 4.24 3.44 0.80 0.055 0.230

16 2.92 4.19 3.39 0.80 0.055 0.230

17 2.69 4.13 3.33 0.80 0.055 0.230

18 2.46 4.08 3.28 0.80 0.055 0.230

19 2.23 4.02 3.22 0.80 0.055 0.230

20 2.00 3.97 3.17 0.80 0.055 0.230

21 1.77 3.91 3.11 0.80 0.055 0.230

22 1.54 3.86 3.06 0.80 0.055 0.230

23 1.31 3.80 3.00 0.80 0.055 0.230

24 1.08 3.75 2.95 0.80 0.055 0.230

25 0.85 3.69 2.89 0.80 0.055 0.230

26 0.62 3.64 2.84 0.80 0.055 0.230

27 0.39 3.58 2.78 0.80 0.055 0.230

28 0.16 3.53 2.73 0.80 0.055 0.155

29 0.00 3.47 2.67 0.80 0.055 0.000

30 0.00 3.42 2.62 0.80 0.055 0.000

31 0.00 3.36 2.56 0.80 0.055 0.000

32 0.00 3.31 2.51 0.80 0.055 0.000

33 0.00 3.26 2.46 0.80 0.055 0.000

34 0.00 3.20 2.40 0.80 0.055 0.000

35 0.00 3.15 2.35 0.80 0.055 0.000

36 0.00 3.09 2.29 0.80 0.055 0.000

37 0.00 3.04 2.24 0.80 0.055 0.000

38 0.00 2.98 2.18 0.80 0.055 0.000

39 0.00 2.93 2.13 0.80 0.055 0.000

40 0.00 2.87 2.07 0.80 0.055 0.000

41 0.00 2.82 2.02 0.80 0.055 0.000

42 0.00 2.76 1.96 0.80 0.055 0.000

43 0.00 2.71 1.91 0.80 0.055 0.000

44 0.00 2.65 1.85 0.80 0.055 0.000

45 0.00 2.60 1.80 0.80 0.055 0.000

46 0.00 2.54 1.74 0.80 0.055 0.000

47 0.00 2.49 1.69 0.80 0.055 0.000

48 0.00 2.43 1.63 0.80 0.055 0.000

49 0.00 2.38 1.58 0.80 0.055 0.000

50 0.00 2.32 1.52 0.80 0.055 0.000

Year

 

  



- Hitunglah total emisi karbon selama 50 tahun (total carbon emission – 

Mton CO2/year); 

Total carbon emission (Mton CO2/year)  = 6.60 Mton CO2/year 

- Tentukan emisi karbon tahun pertama (carbon emission year 1 – Mton 

CO2/year); 

Carbon emission year 1 (Mton CO2/year) = 0.230 Mton CO2/year 

- Tentukan emisi karbon tahun ke-50 (carbon emission year 50 – Mton 

CO2/year); 

Carbon emission year 50 (Mton CO2/year) = 0.000 Mton CO2/year 

C. Kondisi Adanya Bendungan (Canal Blocking) 

- Hitunglah cadangan karbon awal (initial carbon stock); 

Initial Carbon Stock  = Peat Volume*Carbon Content*BD*Carbon Ratio 

 = 36070401.79*50%*0.15*3.67 

 = 6.60 Mton CO2 

- Siapkan parameter lainnya yang diperlukan, yaitu: 

a. Luas wilayah (area – 19.06 m2); 

b. Elevasi lahan gambut awal rerata (initial average peat surface level 

– 5.065 m); 

c. Kedalaman saluran awal rerata (initial canal bottom depth – 1.33 m); 

d. Elevasi muka air musim kering (dry season river level – 0.99 m); 

e. Kandungan karbon gambut dangkal (carbon content shallow peat – 

50%); 

f. Kandungan oksidasi karbon gambut (carbon content oxidation – 

80%); 

g. Bulk density karbon kering (dry bulk density – 0.15 g/cm3); 

Dikarenakan ketebalan gambut pada kawasan studi memiliki rata-

rata sebesar 1.876 m, sehingga untuk ketebalan 0-2 m memiliki nilai 

bulk density sebesar 0.15 g/cm3. 

h. Rasio karbon (carbon ratio – 3.67); 

i. Kedalaman air tanah awal (ground water depth start – 0.3 m) 

  



- Hitunglah elevasi air tanah minimum (ground water level minimum - m); 

GWL minimum (m) = initial average peat surface level – ground water 

depth start 

 = 5.065 – 0.3 

 = 4.77 m 

- Tentukan kedalaman air tanah akhir (ground water depth end – 0,0 m); 

- Hitunglah laju penurunan gambut awal (subsidence start – m/y); 

Subsidence start (m/y)  =  0.015+0.0498*GWD start 

 =  0.015+(0.0498*0.3) 

 =  0.030 m/y 

- Hitunglah laju penurunan gambut akhir (subsidence end – m/y); 

Subsidence end (m/y)  =  0.015+0.0498*GWD end 

 =  0.015+(0.0498*0.0) 

 =  0.015 m/y 

  



- Langkah selanjutnya hitunglah perkiraan karbon emisi setiap tahunnya selama 50 tahun kedepan. Berikut merupakan 

hasil perhitungannya; 

Tabel 1.20 Emisi Karbon di Kawasan Sei Ahas Selama 50 Tahun (Canal Blocking) 

Peat stock

Average 

Surface 

Level

GWL GWD Subsidence Emission

(MtonCO2) (m) (m) (m) (m) (MtonCO2/y)

0 6.60 5.07 4.77 0.30 0.030 0.126

1 6.47 5.04 4.77 0.27 0.028 0.119

2 6.35 5.01 4.77 0.24 0.027 0.113

3 6.24 4.98 4.77 0.21 0.026 0.108

4 6.13 4.95 4.77 0.19 0.024 0.102

5 6.03 4.93 4.77 0.16 0.023 0.097

6 5.93 4.91 4.77 0.14 0.022 0.092

7 5.84 4.88 4.77 0.12 0.021 0.088

8 5.75 4.86 4.77 0.10 0.020 0.084

9 5.67 4.84 4.77 0.08 0.019 0.079

10 5.59 4.82 4.77 0.06 0.018 0.075

11 5.52 4.81 4.77 0.04 0.017 0.072

12 5.44 4.79 4.77 0.02 0.016 0.068

13 5.38 4.77 4.77 0.01 0.015 0.065

14 5.31 4.76 4.76 0.00 0.015 0.063

15 5.25 4.74 4.74 0.00 0.015 0.063

16 5.18 4.73 4.73 0.00 0.015 0.063

17 5.12 4.71 4.71 0.00 0.015 0.063

18 5.06 4.70 4.70 0.00 0.015 0.063

19 5.00 4.68 4.68 0.00 0.015 0.063

20 4.93 4.67 4.67 0.00 0.015 0.063

21 4.87 4.65 4.65 0.00 0.015 0.063

22 4.81 4.64 4.64 0.00 0.015 0.063

23 4.74 4.62 4.62 0.00 0.015 0.063

24 4.68 4.61 4.61 0.00 0.015 0.063

25 4.62 4.59 4.59 0.00 0.015 0.063

26 4.56 4.58 4.58 0.00 0.015 0.063

27 4.49 4.56 4.56 0.00 0.015 0.063

28 4.43 4.55 4.55 0.00 0.015 0.063

29 4.37 4.53 4.53 0.00 0.015 0.063

30 4.30 4.52 4.52 0.00 0.015 0.063

31 4.24 4.50 4.50 0.00 0.015 0.063

32 4.18 4.49 4.49 0.00 0.015 0.063

33 4.11 4.47 4.47 0.00 0.015 0.063

34 4.05 4.46 4.46 0.00 0.015 0.063

35 3.99 4.44 4.44 0.00 0.015 0.063

36 3.93 4.43 4.43 0.00 0.015 0.063

37 3.86 4.41 4.41 0.00 0.015 0.063

38 3.80 4.40 4.40 0.00 0.015 0.063

39 3.74 4.38 4.38 0.00 0.015 0.063

40 3.67 4.37 4.37 0.00 0.015 0.063

41 3.61 4.35 4.35 0.00 0.015 0.063

42 3.55 4.34 4.34 0.00 0.015 0.063

43 3.49 4.32 4.32 0.00 0.015 0.063

44 3.42 4.31 4.31 0.00 0.015 0.063

45 3.36 4.29 4.29 0.00 0.015 0.063

46 3.30 4.28 4.28 0.00 0.015 0.063

47 3.23 4.26 4.26 0.00 0.015 0.063

48 3.17 4.25 4.25 0.00 0.015 0.063

49 3.11 4.23 4.23 0.00 0.015 0.063

50 3.04 4.22 4.22 0.00 0.015 0.063

Year

 

  



- Hitunglah total emisi karbon selama 50 tahun (total carbon emission – 

Mton CO2/year); 

Total carbon emission (Mton CO2/year)  = 3.62 Mton CO2/year 

- Tentukan emisi karbon tahun pertama (carbon emission year 1 – Mton 

CO2/year); 

Carbon emission year 1 (Mton CO2/year) = 0.126 Mton CO2/year 

- Tentukan emisi karbon tahun ke-50 (carbon emission year 50 – Mton 

CO2/year); 

Carbon emission year 50 (Mton CO2/year) = 0.063 Mton CO2/year 

D. Kondisi Adanya Bendungan dan Penghutanan Kembali (Canal Blocking 

and Reforestation) 

- Hitunglah cadangan karbon awal (initial carbon stock); 

Initial Carbon Stock  = Peat Volume*Carbon Content*BD*Carbon Ratio 

 = 36070401.79*50%*0.15*3.67 

 = 6.60 Mton CO2 

- Siapkan parameter lainnya yang diperlukan, yaitu: 

a. Luas wilayah (area – 19.06 m2); 

b. Elevasi lahan gambut awal rerata (initial average peat surface level 

– 5.065 m); 

c. Kedalaman saluran awal rerata (initial canal bottom depth – 1.33 m); 

d. Elevasi muka air musim kering (dry season river level – 0.99 m); 

e. Kandungan karbon gambut dangkal (carbon content shallow peat – 

50%); 

f. Kandungan oksidasi karbon gambut (carbon content oxidation – 

80%); 

g. Bulk density karbon kering (dry bulk density – 0.15 g/cm3); 

Dikarenakan ketebalan gambut pada kawasan studi memiliki rata-

rata sebesar 1.876 m, sehingga untuk ketebalan 0-2 m memiliki nilai 

bulk density sebesar 0.15 g/cm3. 

h. Rasio karbon (carbon ratio – 3.67); 

i. Kedalaman air tanah awal (ground water depth start – 0.3 m) 

- Hitunglah elevasi air tanah minimum (ground water level minimum - m); 

GWL minimum (m) = initial average peat surface level – ground water 

depth start 



 = 5.065 – 0.30 

 = 4.77 m 

- Tentukan kedalaman air tanah akhir (ground water depth end – 0,0 m); 

- Hitunglah laju penurunan gambut awal (subsidence start – m/y); 

Subsidence start (m/y)  =  0.0706*GWD start 

 =  0.0706*0.3 

 =  0.021 m/y 

- Hitunglah laju penurunan gambut akhir (subsidence end – m/y); 

Subsidence end (m/y)  =  0.0706*GWD end 

 =  0.0706*0.0 

 =  0.000 m/y 

  



- Langkah selanjutnya hitunglah perkiraan karbon emisi setiap tahunnya selama 50 tahun kedepan. Berikut merupakan 

hasil perhitungannya; 

Tabel 1.21 Emisi Karbon di Kawasan Sei Ahas Selama 50 Tahun (Canal Blocking and Resforestation) 

Peat stock

Average 

Surface 

Level

GWL GWD Subsidence Emission

(MtonCO2) (m) (m) (m) (m) (MtonCO2/y)

0 6.60 5.07 4.77 0.30 0.021 0.089

1 6.51 5.04 4.77 0.28 0.020 0.083

2 6.43 5.02 4.77 0.26 0.018 0.077

3 6.35 5.01 4.77 0.24 0.017 0.071

4 6.28 4.99 4.77 0.22 0.016 0.066

5 6.21 4.97 4.77 0.21 0.015 0.062

6 6.15 4.96 4.77 0.19 0.014 0.057

7 6.10 4.94 4.77 0.18 0.013 0.053

8 6.04 4.93 4.77 0.17 0.012 0.049

9 5.99 4.92 4.77 0.16 0.011 0.046

10 5.95 4.91 4.77 0.14 0.010 0.043

11 5.90 4.90 4.77 0.13 0.009 0.040

12 5.86 4.89 4.77 0.12 0.009 0.037

13 5.83 4.88 4.77 0.12 0.008 0.034

14 5.79 4.87 4.77 0.11 0.008 0.032

15 5.76 4.87 4.77 0.10 0.007 0.030

16 5.73 4.86 4.77 0.09 0.007 0.028

17 5.70 4.85 4.77 0.09 0.006 0.026

18 5.68 4.85 4.77 0.08 0.006 0.024

19 5.65 4.84 4.77 0.07 0.005 0.022

20 5.63 4.83 4.77 0.07 0.005 0.021

21 5.61 4.83 4.77 0.06 0.005 0.019

22 5.59 4.82 4.77 0.06 0.004 0.018

23 5.57 4.82 4.77 0.06 0.004 0.017

24 5.56 4.82 4.77 0.05 0.004 0.015

25 5.54 4.81 4.77 0.05 0.003 0.014

26 5.53 4.81 4.77 0.04 0.003 0.013

27 5.52 4.81 4.77 0.04 0.003 0.012

28 5.50 4.80 4.77 0.04 0.003 0.011

29 5.49 4.80 4.77 0.04 0.003 0.011

30 5.48 4.80 4.77 0.03 0.002 0.010

31 5.47 4.80 4.77 0.03 0.002 0.009

32 5.46 4.79 4.77 0.03 0.002 0.009

33 5.45 4.79 4.77 0.03 0.002 0.008

34 5.45 4.79 4.77 0.02 0.002 0.007

35 5.44 4.79 4.77 0.02 0.002 0.007

36 5.43 4.79 4.77 0.02 0.002 0.006

37 5.42 4.78 4.77 0.02 0.001 0.006

38 5.42 4.78 4.77 0.02 0.001 0.006

39 5.41 4.78 4.77 0.02 0.001 0.005

40 5.41 4.78 4.77 0.02 0.001 0.005

41 5.40 4.78 4.77 0.01 0.001 0.004

42 5.40 4.78 4.77 0.01 0.001 0.004

43 5.39 4.78 4.77 0.01 0.001 0.004

44 5.39 4.78 4.77 0.01 0.001 0.004

45 5.39 4.78 4.77 0.01 0.001 0.003

46 5.38 4.78 4.77 0.01 0.001 0.003

47 5.38 4.77 4.77 0.01 0.001 0.003

48 5.38 4.77 4.77 0.01 0.001 0.003

49 5.38 4.77 4.77 0.01 0.001 0.002

50 5.37 4.77 4.77 0.01 0.001 0.002

Year

 

  



- Hitunglah total emisi karbon selama 50 tahun (total carbon emission – 

Mton CO2/year); 

Total carbon emission (Mton CO2/year)  = 1.23 Mton CO2/year 

- Tentukan emisi karbon tahun pertama (carbon emission year 1 – Mton 

CO2/year); 

Carbon emission year 1 (Mton CO2/year) = 0.089 Mton CO2/year 

- Tentukan emisi karbon tahun ke-50 (carbon emission year 50 – Mton 

CO2/year); 

Carbon emission year 50 (Mton CO2/year) = 0.002 Mton CO2/year 

 


